Notice
The company reserves the right to revise this publication or to change its contents without notice. Information contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse) of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, transmitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trademarks of their respective companies. They are mentioned for identification purposes only and are not intended as an endorsement of that product or its manufacturer.
© February 2007

Trademarks
This product incorporates copyright protection technology that is protected by method claims of certain U.S. patents and other intellectual property rights owned by Macrovision Corporation and other rights owners. Use of this copyright protection technology must be authorized by Macrovision Corporation, and is intended for home or other limited viewing uses only unless otherwise authorized by Macrovision Corporation. Reverse engineering or disassembly is prohibited.
Intel Core is a trademarks/registered trademarks of Intel Corporation.
SRS is a trademark of SRS Labs, Inc.
WOW technology is incorporated under license from SRS Labs, Inc.
FCC Statement
(Federal Communications Commission)
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Re orient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the service representative or an experienced radio/TV technician for help.

Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not expressly approved by the manufacturer for compliance with the above standards could void your authority to operate the equipment.
IMPORTANT SAFETY INSTRUCTIONS

Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet basement or near a swimming pool.
2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There may be a remote risk of electrical shock from lightning.
3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit (Full Range AC/DC Adapter - AC Input 100 - 240V, 50 - 60Hz/ DC Output 20V, 6.5A (130W) minimum).

CAUTION

Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, TELECOMMUNICATION LINE CORD

This Computer’s Optical Device is a Laser Class 1 Product
Instructions for Care and Operation

The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. **Don’t drop it, or expose it to shock.** If the computer falls, the case and the components could be damaged.

   ![Diagram 1: Do not expose the computer to any shock or vibration.](image1)
   ![Diagram 2: Do not place it on an unstable surface.](image2)
   ![Diagram 3: Do not place anything heavy on the computer.](image3)

2. **Keep it dry, and don’t overheat it.** Keep the computer and power supply away from any kind of heating element. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.

   ![Diagram 4: Do not expose it to excessive heat or direct sunlight.](image4)
   ![Diagram 5: Do not leave it in a place where foreign matter or moisture may affect the system.](image5)
   ![Diagram 6: Don’t use or store the computer in a humid environment.](image6)
   ![Diagram 7: Do not place the computer on any surface that will block the Vents/Fan Intakes.](image7)
3. **Avoid interference.** Keep the computer away from high capacity transformers, electric motors, and other strong magnetic fields. These can hinder proper performance and damage your data.

4. **Follow the proper working procedures for the computer.** Shut the computer down properly and don’t forget to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

<table>
<thead>
<tr>
<th>Do not turn off the power until you properly shut down all programs.</th>
<th>Do not turn off any peripheral devices when the computer is on.</th>
<th>Do not disassemble the computer by yourself.</th>
<th>Perform routine maintenance on your computer.</th>
</tr>
</thead>
</table>

5. **Take care when using peripheral devices.**

| Use only approved brands of peripherals. | Unplug the power cord before attaching peripheral devices. |
Power Safety

The computer has specific power requirements:

- Only use a power adapter approved for use with this computer.
- Your AC/DC adapter may be designed for international travel but it still requires a steady, uninterrupted power supply. If you are unsure of your local power specifications, consult your service representative or local power company.
- The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong is an important safety feature; do not defeat its purpose. If you do not have access to a compatible outlet, have a qualified electrician install one.
- When you want to unplug the power cord, be sure to disconnect it by the plug head, not by its wire.
- Make sure the socket and any extension cord(s) you use can support the total current load of all the connected devices.
- Before cleaning the computer, make sure it is disconnected from any external power supplies (i.e. AC/DC adapter or car adapter).

---

<table>
<thead>
<tr>
<th>Do not plug in the power cord if you are wet.</th>
<th>Do not use the power cord if it is broken.</th>
<th>Do not place heavy objects on the power cord.</th>
</tr>
</thead>
</table>
Battery Precautions

- Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
- Do not remove any batteries from the computer while it is powered on.
- Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire.
- Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
- Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qualified service personnel.
- Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries may explode or leak if exposed to fire, or improperly handled or discarded.
- Keep the battery away from metal appliances.
- Affix tape to the battery contacts before disposing of the battery.
- Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life, under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.
Preface

Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the power supply. Then refer servicing to qualified service personnel under any of the following conditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and screw(s) before turning the computer on.
Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hardware and software. Make sure your “papers” are handy.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intakes while the computer is in use.
On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting, keep these points in mind:

**Hand-carry the notebook** - For security, don’t let it out of your sight. In some areas, computer theft is very common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knocking the computer against hard objects.

**Beware of Electromagnetic fields** - Devices such as metal detectors & X-ray machines can damage the computer, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). **Note:** Some airports also scan luggage with these devices.

**Fly safely** - Most airlines have regulations about the use of computers and other electronic devices in flight. These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

**Get power where you can** - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies) charged.

**Keep it dry** - If you move quickly from a cold to a warm location, water vapor can condense inside the computer. Wait a few minutes before turning it on so that any moisture can evaporate.
Developing Good Work Habits

Developing good work habits is important if you need to work in front of the computer for long periods of time. Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or other joints. The following are some tips to reduce the strain:

- Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.
- Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a footrest if necessary.
- Use a chair with a back and adjust it to support your lower back comfortably.
- Sit straight so that your knees, hips and elbows form approximately 90-degree angles when you are working.
- Take periodic breaks if you are using the computer for long periods of time.

Remember to:
- Alter your posture frequently.
- Stretch and exercise your body several times a day.
- Take periodic breaks when you work at the computer for long periods of time. Frequent and short breaks are better than fewer and longer breaks.
Preface

Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and shoulders.

- Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
- Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
- Position the display directly in front of you at a comfortable viewing distance.
- Adjust the display-viewing angle to find the best position.
Preface

Contents

Notice .................................................................I  
FCC Statement ....................................................II  
Instructions for Care and Operation .......................IV  
Power Safety .......................................................VI  
Battery Precautions .............................................VII  
Cleaning .......................................................... VIII  
Servicing .......................................................... VIII  
Travel Considerations ...........................................IX

Quick Start Guide

Overview .............................................................1-1  
Advanced Users ..................................................1-2  
Beginners and Not-So-Advanced Users ....................1-2  
Warning Boxes ..................................................1-2  
Not Included .......................................................1-2  
Model Differences ..............................................1-3  
System Software ..................................................1-4  
System Startup ....................................................1-5  
System Map: LCD Panel Open ...............................1-6  
System Map: Rear View ......................................1-12  
System Map: Right View .....................................1-13  
System Map: Left View ........................................1-14  
System Map: Bottom View ...................................1-15  
Windows Vista Start Menu & Control Panel .............1-16  
Video Features ....................................................1-17  
Display Devices & Options ....................................1-18  
Power Options ....................................................1-19

Storage Devices, Mouse, Audio & Printer

Overview .............................................................2-1  
Hard Disk Drive ...................................................2-2  
Optical Device .....................................................2-3  
Loading Discs .....................................................2-3  
Handling CDs or DVDs .........................................2-4  
DVD Regional Codes ..........................................2-5  
7-in-1 Card Reader ..............................................2-6  
ExpressCard Slot ...............................................2-7  
Inserting and Removing ExpressCards ....................2-7  
Application Hot Key .............................................2-8  
TouchPad and Buttons/Mouse ...............................2-9  
Audio Features ...................................................2-10
Preface

Configuring the Infrared Settings for FIR ........... 2-11
Adding a Printer ........................................ 2-12
USB Printer ............................................. 2-12
Install Instructions: ........................................ 2-12
Parallel Printer ........................................... 2-12

Power Management
Overview .................................................... 3-1
The Power Sources ....................................... 3-2
AC/DC Adapter ............................................ 3-2
Battery ...................................................... 3-2
Turning on the Computer .............................. 3-3
Power Plans ............................................... 3-4
System Power Options .................................. 3-6
Hibernate vs. Shutdown .............................. 3-6
Stand by Mode vs. Hibernate Mode ............... 3-6
Sleep ....................................................... 3-7
Hibernate .................................................. 3-7
Configuring the Power Button ....................... 3-8
Battery Information ...................................... 3-9
Battery Power ............................................ 3-9
Conserving Battery Power ........................... 3-10
Battery Life ............................................... 3-11
New Battery ............................................. 3-11
Recharging the Battery with the AC/DC Adapter .... 3-11

Drivers & Utilities
RAID Setup .............................................. 4-1
What to Install .......................................... 4-1
Module Driver Installation .......................... 4-1
Driver Installation ...................................... 4-2
Manual Driver Installation ......................... 4-3
Updating/Reinstalling Individual Drivers .......... 4-4
User Account Control (Win Vista) .................. 4-4
Windows Security Message ....................... 4-4
New Hardware Found ............................... 4-4
Driver Installation Procedure ..................... 4-5
Chipset .................................................... 4-5
Video (VGA) ............................................ 4-5
Audio .................................................... 4-5
Modem .................................................... 4-5
LAN ...................................................... 4-5
TouchPad ................................................ 4-6
Card Reader/ExpressCard .......................... 4-6
Hot Key Utility .......................................... 4-6
Optional Drivers ....................................... 4-6
Wireless LAN .......................................... 4-7
PC Camera ............................................. 4-7

Proper handling of the Battery Pack ............... 3-12
Battery FAQ ............................................. 3-13
Preface

Bluetooth ................................................................. 4-7
TV Tuner ................................................................. 4-7

BIOS Utilities
Overview ................................................................. 5-1
The Power-On Self Test (POST) ......................... 5-2
Failing the POST ................................................... 5-3
Fatal Errors ........................................................... 5-3
Non-Fatal Errors .................................................... 5-3
The Setup Program ................................................ 5-4
Entering Setup ......................................................... 5-4
Setup Screens ......................................................... 5-5
Main Menu ............................................................ 5-6
System Time & Date (Main Menu) ....................... 5-6
IDE Channel 0/1 Master/Slave (Main Menu) .......... 5-7
Installed Memory (Main Menu) .......................... 5-7
Advanced Menu .................................................... 5-8
Advanced Chipset Control (Advanced Menu) ...... 5-9
National 381 SIO Control Sub-Menu (Advanced Menu) ........ 5-10
Reset Configuration Data: (Advanced Menu) .... 5-10
Legacy USB Support: (Advanced Menu) .......... 5-10
Boot-time Diagnostic Screen: (Advanced Menu) .. 5-10
Power On Boot Beep: (Advanced Menu) ........... 5-10
Battery Low Alarm Beep: (Advanced Menu) ...... 5-10
Security Menu ....................................................... 5-11
Set Supervisor Password (Security Menu) ............ 5-11
Password on boot: (Security Menu) ....................... 5-12
Boot Menu ............................................................ 5-13
Exit Menu ............................................................. 5-14

Upgrading The Computer
Overview ............................................................ 6-1
When Not to Upgrade ........................................... 6-2
Removing the Battery ............................................ 6-3
Upgrading the Hard Disk Drive(s) ......................... 6-4
Upgrading the System Memory (RAM) .................. 6-6
Upgrading the Optical (CD/DVD) Device(s) ......... 6-9

Modules
Overview ............................................................ 7-1
Wireless LAN Module ............................................ 7-2
Intel WLAN Driver Installation .......................... 7-2
802.11 b/g WLAN Driver Installation .................. 7-2
Connecting to a Wireless Network ....................... 7-3
Windows Mobility Center .................................... 7-6
PC Camera Module .............................................. 7-7
PC Camera Driver Installation ......................... 7-7
PC Camera Audio Setup ..................................... 7-8
BisonCap ............................................................. 7-10
<table>
<thead>
<tr>
<th>Preface</th>
</tr>
</thead>
<tbody>
<tr>
<td>TouchPad ................................................. D-26</td>
</tr>
<tr>
<td>Card Reader/ExpressCard ......................... D-26</td>
</tr>
<tr>
<td>Hot Key Utility ........................................... D-26</td>
</tr>
<tr>
<td>AutoMail Checker ........................................ D-27</td>
</tr>
<tr>
<td>Module Drivers .......................................... D-27</td>
</tr>
<tr>
<td>PC Camera Driver Installation ..................... D-28</td>
</tr>
<tr>
<td>Intel WLAN Driver Installation ..................... D-29</td>
</tr>
<tr>
<td>802.11 b/g WLAN Driver Installation .............. D-30</td>
</tr>
<tr>
<td>Bluetooth Driver Installation ...................... D-31</td>
</tr>
<tr>
<td>Mini-PCI TV Tuner Module .............................. D-32</td>
</tr>
<tr>
<td>Installing the LifeView FlyDVB-T Driver .......... D-32</td>
</tr>
<tr>
<td>Installing the MPC622-MCE Driver ................ D-33</td>
</tr>
<tr>
<td>Installing the MPC788 Driver &amp; ..................... D-33</td>
</tr>
<tr>
<td>Cyberlink PowerCinema ................................. D-33</td>
</tr>
<tr>
<td>Setting Up SATA RAID .................................. D-34</td>
</tr>
</tbody>
</table>
Chapter 1: Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the computer and to getting your system started. The remainder of the manual covers the following:

• Chapter 2  A guide to using some of the main features of the computer e.g. the storage devices (hard disk, optical device, 7-in-1 card reader, ExpressCard/34/54), Application Hot Key, TouchPad & Mouse, Audio Features, FIR Settings & Printer.
• Chapter 3  The computer’s power saving options.
• Chapter 4  The installation of the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems.
• Chapter 5  An outline of the computer’s built-in software or BIOS (Basic Input Output System).
• Chapter 6  Instructions for upgrading your computer.
• Chapter 7  A quick guide to the computer’s Wireless LAN, Bluetooth, PC Camera, TV Tuner and RAID modules (some of which may be optional depending on your purchase configuration).
• Chapter 8  A troubleshooting guide.
• Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external devices.
• Appendix B  Information on the NVIDIA Video driver controls.
• Appendix C  The computer’s specification.
• Appendix D  Information on the Window’s XP OS.
Quick Start Guide

Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful to refer to “Drivers & Utilities” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on page 6 - 1 in the User’s Manual. You may also find the notes marked with a \( \mathcal{F} \) of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then the information contained in this Quick Start Guide should be enough to get you up and running. Eventually you should try to look through all the documentation (more detailed descriptions of the functions, setup and system controls are covered in the remainder of the User’s Manual), but do not worry if you do not understand everything the first time. Keep this manual nearby and refer to it to learn as you go. You may find it useful to refer to the notes marked with a \( \mathcal{F} \) as indicated in the margin. For a more detailed description of any of the interface ports and jacks see “Interface (Ports & Jacks)” on page A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the \( \mathcal{F} \) symbol. Also please note the safety and handling instructions as indicated in the Preface.

Not Included
Operating Systems (e.g. Windows Vista/ Windows XP etc.) and applications (e.g. word processing, spreadsheet and database programs) have their own manuals, so please consult the appropriate manuals.

1 - 2 Overview
Model Differences
This notebook series includes two different design types, however only one design is pictured in this manual.

Drivers
If you are installing new system software, or are re-configuring your computer for a different system, you will need to install the appropriate drivers. Drivers are programs which act as an interface between the computer and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order listed in Table 4 - 1, on page 4 - 3. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your system hasn’t been properly configured (your service representative may have already done that for you), refer to “Drivers & Utilities” on page 4 - 1 for installation instructions.

Ports and Jacks
See “Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your computer to communicate with external devices, connect to the internet etc.
System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you are re-configuring your computer for a different system, you will find the following operating systems are supported:

<table>
<thead>
<tr>
<th>Operating System &amp; Version</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Windows XP (Home or Professional)</td>
<td></td>
</tr>
<tr>
<td>*Windows XP Media Center Edition</td>
<td></td>
</tr>
<tr>
<td>Windows Vista (64-bit) Home Basic Edition</td>
<td>In order to run Windows Vista without limitations or decreased performance, your computer requires a minimum 1GB of system memory (RAM).</td>
</tr>
<tr>
<td>Windows Vista (64-bit) Home Premium Edition</td>
<td></td>
</tr>
<tr>
<td>Windows Vista (64-bit) Business/Enterprise/Ultimate Editions</td>
<td></td>
</tr>
</tbody>
</table>

*Note: For information on the Windows XP OS (specifically power, video and driver information) see “Windows XP Information” on page D - 1.

Table 1 - 1 - Operating Systems Supported

TV Tuner Module Support
Note that the TV Tuner module (factory) options in Windows Vista are supported by the Windows Media Center software which comes built-in to the Windows Vista Home Premium and Ultimate Editions only.

If your purchase includes a TV Tuner option, and you are re-configuring your system for a different system, you should install either Windows Home Premium or Ultimate Editions only.
System Startup

1. Remove all packing materials.
2. Place the computer on a stable surface.
3. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
4. Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC power cord into an outlet, and connect the AC power cord to the AC/DC adapter.
5. Move the LCD latches at the front of the computer outwards towards the sides of the computer, and hold the right latch in place to release the top cover.
6. Raise the lid/LCD to a comfortable viewing angle, and press the power button (make sure the Audio "DJ" player is turned off) to turn the computer “on”.
7. Adjust the LCD panel to a comfortable viewing angle.
8. The LED indicators show the power and battery status of the computer and display information on the power status of the PC Camera, Bluetooth and Wireless LAN modules.

**Shutdown**

Note that you should always shut your computer down by choosing the **Shut Down** command from the **Lock Button Menu** in **Windows Vista**. This will help prevent hard disk or system problems.

*Figure 1 - 1 - Computer With AC/DC Adapter Plugged In*
System Map: LCD Panel Open

**Figure 1 - 2**
Front View
LCD Panel Open

1. Optional Built-In PC Camera
2. LCD
3. Hot Key Buttons
4. Power Button
5. Keyboard
6. TouchPad and Buttons
7. Audio "DJ" Controls
8. Built-In Microphone
9. Audio "DJ" LED Display Panel (Including LED Indicators)

**Audio "DJ" & Power Button**

Make sure that the Audio "DJ" player is off before pressing the power button to turn the computer on.

**Wireless Device Operation Aboard Aircraft**

The use of any portable electronic transmission devices (e.g. WLAN or Bluetooth) aboard aircraft is usually prohibited. Make sure any wireless modules are OFF if you are using the computer aboard aircraft.

Use the appropriate function key combination (see **Table 1 - 4, on page 1 - 9**) to toggle power to any wireless modules, and check the LED indicators to see if any modules are powered on or not (see **Table 1 - 2, on page 1 - 7**).
LED Indicators

The LED indicators on the computer display helpful information about the current status of the computer.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Green</td>
<td>The Computer is On</td>
</tr>
<tr>
<td></td>
<td>Blinking</td>
<td>The Computer is In Stand by Mode</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>The AC/DC Adapter is Plugged In</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>Number Lock is Activated</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>Caps Lock is Activated</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>Scroll Lock is Activated</td>
</tr>
<tr>
<td>1</td>
<td>Orange</td>
<td>The Battery is Charging</td>
</tr>
<tr>
<td></td>
<td>Blinking</td>
<td>The Battery has Reached Critically</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>Low Power Status</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>The Battery is Fully Charged</td>
</tr>
<tr>
<td>2</td>
<td>Green</td>
<td>Second Battery Indicator (Colors</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Displayed as Above)</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>Hard Disk Activity</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>The PC Camera Module is Powered On</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>The Bluetooth Module is Powered On</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>The WLAN Module is Powered On</td>
</tr>
<tr>
<td></td>
<td>Blinking</td>
<td>New Mail Has Arrived</td>
</tr>
<tr>
<td>1</td>
<td>Amber</td>
<td></td>
</tr>
</tbody>
</table>

*Table 1 - 2 - LED indicators*
Quick Start Guide

Hot Key Buttons & Keyboard

These buttons give instant access to the default Internet browser and e-mail program, and to a user-defined application, with one quick button press. To use the “user-defined application Hot Key Button”, you must install the driver (see “Hot Key Utility” on page 4 - 6). See “Application Hot Key” on page 2 - 8 for configuration instructions.

Table 1 - 3 - Hot Key Buttons

<table>
<thead>
<tr>
<th>Hot Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>💌</td>
<td>Activate the Default E-Mail Browser</td>
</tr>
<tr>
<td>🌐</td>
<td>Activate the Default Internet Program</td>
</tr>
<tr>
<td>🏡</td>
<td>Activate the user specified application e.g. Microsoft Word or Excel</td>
</tr>
</tbody>
</table>

The keyboard has a numerical keypad for easy numeric data input, and features Function Keys to allow you to change operational features instantly.

Activate the Number Lock feature by pressing the Num Lk key at the top right of the keyboard. You may check if Number Lock is enabled or not by looking at the LED status indicators.
Hot Key Buttons & Keyboard 1 - 9

<table>
<thead>
<tr>
<th>Keys</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fn + ~</td>
<td>Play/Pause (in Audio/Video Programs)</td>
</tr>
<tr>
<td>Fn + F1</td>
<td>TouchPad Toggle</td>
</tr>
<tr>
<td>Fn + F2</td>
<td>Fan Automatic Control / Full Power</td>
</tr>
<tr>
<td>Fn + F3</td>
<td>Mute Toggle</td>
</tr>
<tr>
<td>Fn + F4</td>
<td>Sleep Toggle</td>
</tr>
<tr>
<td>Fn + F5</td>
<td>Decrease Audio Volume</td>
</tr>
<tr>
<td>Fn + F6</td>
<td>Increase Audio Volume</td>
</tr>
<tr>
<td>Fn + F7</td>
<td>Display Toggle</td>
</tr>
<tr>
<td>Fn + F8</td>
<td>Decrease LCD Brightness</td>
</tr>
<tr>
<td>Fn + F9</td>
<td>Increase LCD Brightness</td>
</tr>
<tr>
<td>Fn + F10</td>
<td>PC Camera Toggle</td>
</tr>
<tr>
<td>Fn + F11</td>
<td>WLAN Module Toggle</td>
</tr>
<tr>
<td>Fn + F12</td>
<td>Bluetooth Module Toggle</td>
</tr>
<tr>
<td>Fn + Scr Lk</td>
<td>Scroll Lock Toggle</td>
</tr>
</tbody>
</table>

Table 1 - 4 - Function Keys

Figure 1 - 3 - Keyboard

Function Keys

Num Lk & Scr Lk Keys

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will detect and enable it automatically. However, special functions/hot keys unique to the system’s regular keyboard may not work.
Quick Start Guide

System Map: Front View (Audio "DJ")

Figure 1 - 4 - Front View (Audio "DJ")

1. Audio "DJ" Power Button
2. Volume Down
3. Volume Up
4. Repeat
5. LED Display
6. Previous Track
7. Next Track
8. Play/Pause
9. Stop (Press Twice To Eject The CD/DVD)
10. Repeat Mode Indicator
11. Track Indicator
12. Time Indicator
13. Disc Indicator

Audio "DJ" MP3 Track Limit

There is a track limit of **256 tracks** on any MP3 CD/DVD. This means that only the first 256 tracks may be played on any MP3 CD/DVD.

Audio "DJ" & Power Button

Make sure that the Audio "DJ" player is off before pressing the power button to turn the computer on.
Audio "DJ" CD Player

The built-in standalone audio CD player gives direct hardware control for audio CDs/DVDs when the computer is shut down, but has a working power source.

1. Make sure that the computer is shut down (i.e. the operating system is not running) but you have a working power source (either battery or AC Power).
2. Press the Audio "DJ" power button.
3. Press the open button on your CD/DVD device (or press the stop button twice) and carefully place an audio CD onto the disc tray with label-side facing up (DVD drives will also play audio CDs).
4. Gently push the CD/DVD tray in until its lock "clicks" and you are ready to start.
5. The Disc Indicator will flash while data is being accessed.
6. The LED will display the number of tracks.
7. Press the play/pause button to start the CD/DVD.
8. Control the CD/DVD tracking and volume from the control panel.
9. Use the stop button to stop the disc, or press it twice to eject the disk.
10. Press the power button again to turn the player off.

TV Tuner Option

If you have included the optional TV Tuner in your purchase configuration, you can use the supplied remote control unit to control the Audio "DJ".

Disk Eject Warning

Don’t try to eject a CD/DVD while the system is accessing it. This may cause the system to "crash". Stop the disk first then eject it, or press the stop button twice.
Overheating

To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake/Outlet while the computer is in use.

USB Ports

Note that the connections to the USB ports only fit one way, do not force them.
Mini-IEEE 1394 Port

Both Mini-IEEE 1394 ports only support **SELF POWERED** IEEE 1394 devices.

ExpressCard Slot

The ExpressCard Slot accepts either **ExpressCard/34** or **ExpressCard/54** formats.

7-in-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

- MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) / MS Pro (Memory Stick Pro) / MS Duo (requires PC adapter) / Mini SD (requires PC adapter) / RS MMC (requires PC adapter)

USB Ports

Note that the connections to the USB ports only fit one way, do not force them.
Quick Start Guide

System Map: Left View

1. Security Lock Slot
2. Speaker
3. Optional Device Drive Bay
   (for CD/DVD Device, see page 2 - 3, or 2nd SATA Hard Disk, or 2nd Battery)

2nd Battery Notes

Note that the 2nd battery is designed to optimize and boost the power performance of the system.

The system WILL NOT boot up from the 2nd battery alone. Use either the AC/DC adapter or main battery to boot up the system.

The system DOES NOT support the Hot Swap function. Save your work and shut the system down before swapping batteries.

The 2nd battery alone CAN NOT power the system if the NVIDIA GeForce Go 7900 GTX video card is the installed option.

CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to an unexpected power interruption) you may push the end of a straightened paper clip into the emergency eject hole. Do not use a sharpened pencil or any object that may break and become lodged in the hole. Don’t try to remove a floppy disk/CD/DVD while the system is accessing it. This may cause the system to “crash”.

Changing DVD Regional Codes

Go to the Control Panel and double-click Device Manager (Hardware and Sound), then click the + next to DVD/CD-ROM drives. Double-click on the DVD-ROM device to bring up the Properties dialogue box, and select the DVD Region (tab) to bring up the control panel to allow you to adjust the regional code (see “DVD Regional Codes” on page 2 - 5).

DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is permanent. This cannot be altered even if you change your operating system or you use the module in another computer.
Battery Information

Always completely discharge, then fully charge, a new battery before using it. Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges. See “Battery Information” on page 3 - 9 for full instructions.
Windows Vista Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows Vista (and most other Windows versions) are accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk drive, and a shortcut will usually be placed in the Start menu and/or the desktop. You can customize the look of the Start menu by right-clicking the Start menu and selecting Properties from the menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features in Windows (e.g. power, video, network, audio etc.). Windows Vista provides basic controls for many of the features, however many new controls are added (or existing ones are enhanced) when you install the drivers listed in Table 4 - 1, on page 4 - 3. To see all controls it may be necessary to toggle off Category View.

Figure 1 - 9 - Start Menu & Control Panel
Video Features

This computer features different PCI Express video cards, depending on your purchase option (see “Video Card Options” on page C - 3). You can configure display options, from the Display Settings control panel in Windows as long as the appropriate video driver is installed. For more detailed video information see “NVIDIA Video Driver Installation” on page B - 1.

To access Display Settings in Windows:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Adjust screen resolution under the Appearance and Personalization menu (or double-click Personalization > Display Settings).
3. Move the slider to the preferred setting in Resolution: 1 (Figure 1 - 10 on page 1 - 18).
4. Click the arrow, and scroll to the preferred setting in Colors: 2 (Figure 1 - 10 on page 1 - 18).
5. Click Advanced Settings (button) 3 (Figure 1 - 10 on page 1 - 18).
6. Click GeForce Go..... (tab).
7. Click Start the NVIDIA Control Panel 4 (Figure 1 - 10 on page 1 - 18) to access the control panel.
8. The NVIDIA Control Panel can also be accessed by right-clicking the desktop, and then clicking NVIDIA Control Panel.
Display Devices & Options
Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display (connected to the DVI-Out port) or TV (connected to the S-Video-Out jack) as your display device.

![Figure 1 - 10 - Display Settings](image)

### NVIDIA Display Mode

<table>
<thead>
<tr>
<th>NVIDIA Display Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single</td>
<td>One display device is used.</td>
</tr>
<tr>
<td>Clone</td>
<td>Both connected displays output the same view</td>
</tr>
<tr>
<td>Dualview</td>
<td>Both connected displays are treated as separate devices, and act as a virtual desktop</td>
</tr>
</tbody>
</table>

*Table 1 - 5 - Display Modes Available*

1 - 18 Video Features
Power Options

The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 16) allows you to configure power management features for your computer. You can conserve power by means of power plans and configure the options for the power button, sleep button, computer lid (when closed), display and sleep mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to create a new plan. Click Change Plan Settings and click Change advanced power settings to access further configuration options.

Pay attention to the instructions on battery care in “Battery Information” on page 3 - 9.

Note: Sleep is the default power saving state in Windows Vista

Figure 1 - 11 - Power Options
Chapter 2: Storage Devices, Mouse, Audio & Printer

Overview

Read this chapter to learn more about the following main features and components of the computer:

- Hard Disk Drive
- Optical Device
- 7-in-1 Card Reader
- ExpressCard Slot
- Application Hot Key
- TouchPad and Buttons/Mouse
- Audio Features
- Configuring the Infrared Settings for FIR
- Adding a Printer
Hard Disk Drive

The hard disk drive is used to store your data in the computer. The hard disk can be taken out to accommodate other 2.5” serial (SATA) hard disk drives with a height of 9.5 mm. The hard disk is accessible from the bottom of your computer as seen below. Further details on removing and inserting the hard disk are available in “Upgrading the Hard Disk Drive(s)” on page 6 - 4.
Optical Device

There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual device will depend on the model you purchased (see “Storage Options” on page C-4). The optical device is usually labeled “Drive D:” and may be used as a boot device if properly set in the BIOS (see “Boot Menu” on page 5-13).

Loading Discs

To insert a CD/DVD, press the open button 1 and carefully place a CD/DVD onto the disc tray with label-side facing up (use just enough force for the disc to click onto the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you are ready to start. The busy indicator 2 will light up while data is being accessed, or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupted, insert an object such as a straightened paper clip into the emergency eject hole 3 to open the tray.

Sound Volume Adjustment

How high the sound volume can be set depends on the setting of the volume control within Windows. Click the Volume icon on the taskbar to check the setting. Peripherals must be connected before you turn on the system.
Handling CDs or DVDs

Proper handling of your CDs/DVDs will prevent them from being damaged. Please follow the advice below to make sure that the data stored on your CDs/DVDs can be accessed.

Note the following:

- Hold the CD or DVD by the edges; do not touch the surface of the disc.
- Use a clean, soft, dry cloth to remove dust or fingerprints.
- Do not write on the surface with a pen.
- Do not store or place the CD or DVD in high-temperature areas.
- Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
- Do not bend the CD or DVD.
- Do not drop or subject the CD or DVD to shock.
### DVD Regional Codes

To change the DVD regional codes see “Changing DVD Regional Codes” on page 1-14.

<table>
<thead>
<tr>
<th>Region</th>
<th>Geographical Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USA, Canada</td>
</tr>
<tr>
<td>2</td>
<td>Western Europe, Japan, South Africa, Middle East &amp; Egypt</td>
</tr>
<tr>
<td>3</td>
<td>South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong</td>
</tr>
<tr>
<td>4</td>
<td>South &amp; Central America, Mexico, Australia, New Zealand</td>
</tr>
<tr>
<td>5</td>
<td>N Korea, Russia, Eastern Europe, India &amp; Most of Africa</td>
</tr>
<tr>
<td>6</td>
<td>China</td>
</tr>
</tbody>
</table>

**Table 2-1**

**DVD Regional Coding**

**Figure 2-3**

**DVD Regions**
7-in-1 Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the card into the slot and it will appear as a removable device, and can be accessed in the same way as your hard disk(s). Make sure you install the Card Reader driver (see “Card Reader/ExpressCard” on page 4 - 6).

- MMC (MultiMedia Card)
- SD (Secure Digital)
- MS (Memory Stick)
- MS (Memory Stick Pro)
- MS Duo (requires PC adapter*)
- Mini SD (requires PC adapter*)
- RS MMC (requires PC adapter*)

*Note: The PC adapters are usually supplied with these cards.
ExpressCard Slot

The computer is equipped with an **ExpressCard/34/54** slot that reads Express Card/34 and ExpressCard/54 formats. ExpressCards are the successors to PCMCIA (PC Cards).

ExpressCard/54 is used for applications which require a larger interface slot, e.g. CompactFlash card reader. The number denotes the card width; 54mm for the Express Card/54 and 34mm for the ExpressCard/34. Make sure you install the ExpressCard driver (see “Card Reader/ExpressCard” on page 4 - 6).

Inserting and Removing ExpressCards

- Align the ExpressCard with the slot and push it in until it locks into place.
- To remove an ExpressCard, simply press the card to eject it.

Figure 2 - 5
ExpressCard Slot
Application Hot Key

The hot key button gives instant access to a user-defined application, with one quick button press. To configure a program to open when the application hot key is pressed, install the driver (see “Hot Key Utility” on page 4 - 6), and then follow the instructions below.

1. **Right click** the Hot Key driver icon in the taskbar.
2. Select **Setup** from the menu, scroll to **Application 1** and click to select **Custom**.

3. An **Open** dialog box will appear on the screen.

   ![Open dialog box](image)

4. **Browse** to the directory where the desired application.exe (see the sidebar) program exists.
5. **Double-Click** on the program file or choose **Open**.
The TouchPad is an alternative to the mouse; however, you can also add a mouse to your computer through one of the USB ports. The TouchPad buttons function in much the same way as a two-button mouse. The central button may be configured to function as you require.

Install the TouchPad driver (see page 4 - 6) and then double-click the TouchPad driver icon in the taskbar to configure the functions. You may then configure the TouchPad tapping, buttons, scrolling, pointer motion and sensitivity options to your preferences. The TouchPad may be toggled on/off by means of the Fn + F1 key combination. You will have one of two TouchPad options as pictured below.
Audio Features

You can configure the audio options on your computer from the **Sound** control panel in **Windows**, or from the **Realtek HD Audio Manager** icon in the taskbar/control panel (right-click the taskbar icon to bring up an audio menu). The volume may also be adjusted by means of the **Fn + F5/F6** key combination.

**Sound Volume Adjustment**

The sound volume level is set using the volume control within **Windows** (and the volume function keys on the computer). Click the volume icon in the taskbar to check the setting.

Right-click the icon to access the menu above.

---

2 - 10 Audio Features
Configuring the Infrared Settings for FIR

To configure your computer’s infrared port (on the right of the computer) for Far Infrared (FIR) communication follow these steps:

1. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**).
2. Double-click **Infrared** (Network and Internet Category) icon.
3. Click **Hardware** (tab), and click the **Properties** button.
4. Click the **Change settings** button and click **Advanced** (tab).
5. Select “**Infrared Transceiver A**” and change the **Value** to “**HP HSDL-2300/3600**”.
6. Click **OK > OK**.
7. Restart the computer if prompted to do so.

You can enable/disable the infrared transceiver in the BIOS (see “**National 381 SIO Control Sub-Menu (Advanced Menu)**” on page 5 - 10). For further information, please refer to the manual of the device you wish to connect.

---

**Infrared Communication**

The infrared transceiver operates on a “Line of Sight”.

Make sure nothing is blocking the “Line of Sight” between your system’s transceiver and the destination’s transceiver.
Adding a Printer

The most commonly used peripheral is a printer. The following conventions will help you to add a printer; however it is always best to refer to the printer manual for specific instructions and configuration options.

**USB Printer**
Most new printers have a USB interface connection. You may use any one of the ports to connect the printer.

**Install Instructions:**
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink cartridge etc.).
2. Turn ON the computer.
3. Turn ON the printer.
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. **Windows** will identify the printer and either load one of its own drivers or ask you to supply one. Follow the on-screen instructions.

**Parallel Printer**
This is still a very common type of printer. The install instructions are in the sidebar (you will need to purchase a parallel to USB converter).
Chapter 3: Power Management

Overview

To conserve power, especially when using the battery, your computer power management conserves power by controlling individual components of the computer (the monitor and hard disk drive) or the whole system.

This chapter covers:

- The Power Sources
- Turning on the Computer
- Power Plans
- System Power Options
- Configuring the Power Button
- Battery Information

The computer uses enhanced power saving techniques to give the operating system (OS) direct control over the power and thermal states of devices and processors. For example, this enables the OS to set devices into low-power states based on user settings and information from applications.

OS Note

Power management functions will vary slightly depending on your operating system. For more information it is best to refer to the user's manual of your operating system.

(Note: All pictures used on the following pages are from the Windows Vista OS.)
The Power Sources

The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/DC adapter will damage the computer and its components (see page C - 6).

1. Attach the AC/DC adapter to the DC-In jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an electrical outlet is unavailable. Battery life varies depending on the applications and the configuration you're using. To increase battery life, let the battery discharge completely before recharging (see “How do I completely discharge the battery?” on page 3 - 13).

We recommend that you do not remove the battery. For more information on the battery, please refer to “Battery Information” on page 3 - 9.
Turning on the Computer

Now you are ready to begin using your computer. To turn it on simply press the power button on the front panel.

When the computer is on, you can use the power button as a Sleep/Hibernate hot key button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will shut the computer down). Use Power Options (Hardware and Sound menu) control panel in Windows Vista to configure this feature.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the power button for 4 seconds, or longer, to force the system to turn itself off.

Power Button Sleep

Sleep is the default power mode when the power button is pressed for less than 4 seconds. You may configure the options for the power button from the Power Options (Hardware and Sound menu) control panel in Windows Vista (see your OS’s documentation, or “Configuring the Power Button” on page 3 - 8 for details).

Shut Down

Note that you should always shut your computer down by choosing the Shut Down command from the Lock Button Menu in Windows Vista. This will help prevent hard disk or system problems.
Power Management

Power Plans

The computer can be configured to conserve power by means of **power plans**. You can use (or modify) an existing **power plan**, or create a new one.

The settings may be adjusted to set the **display** to turn off after a specified time, and to send the computer into **Sleep** after a period of inactivity.

Click **Change plan settings** and then click **Change advanced power settings** to access further configuration options in **Advanced Settings**.

![Image of Power Options window with Change advanced power settings highlighted]

---

**Resuming Operation**

If the **display** is off the system can resume by pressing any key on the keyboard.

The system can resume from **Sleep** mode by pressing the **Sleep Button** key combination (Fn + F4), or power button.

**Password**

It is recommended that you enable a password on system resume in order to protect your data.

![Image of Power Options window with Change advanced power settings highlighted]

---

*Figure 3 - 1*

Power Plan Advanced Settings
Each *Windows Power Plan* will also adjust the processor performance of your machine in order to save power. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery power).

Choose **High performance** for maximum performance when the computer is powered from an AC power source. Choose the **Power saver** (bear in mind that this scheme may slow down the overall performance of the computer in order to save power) for maximum power saving when the computer is battery (DC power) powered.
System Power Options

You can use the system power options to stop the computer’s operation and restart where you left off. The system features Sleep and Hibernate power saving states (Hibernate will need to be enabled from power plan Advanced Settings see Figure 3 - 1 on page 3 - 4).

Hibernate vs. Shutdown

Hibernate mode and Shutdown are the same in that the system is off and you need to press the power button to turn it on. Their main difference is:

When you come back from hibernation, you can return to where you last left off (what was on your desktop) without reopening the application(s) and file(s) you last used.

You can use either method depending on your needs.

Stand by Mode vs. Hibernate Mode

If you want to stay away from your work for just a while, you can put the system on Stand by instead of in hibernation. It takes a longer time to wake up the system from Hibernate mode than from Stand by mode. Sleep will effectively act as Hibernate if the computer battery becomes depleted (see “Sleep Mode & Mobile PC Battery” on page 3 - 7).
Sleep
Stand by saves the least amount of power, but takes the shortest time to return to full operation. During Stand by the hard disk is turned off, and the CPU is made to idle at its slowest speed. All open applications are retained in memory. When you are not using your computer for a certain length of time, which you specify in the operating system, it will enter Stand by mode to save power.

Hibernate
Hibernate uses no power and saves all of your information on a part of the hard disk before it turns the system off. Although it saves the most power it takes the longest time to return to full operation. You can set your computer to automatically enter Hibernate when the battery power is almost depleted. You will need to enable Hibernate mode from the Advanced Settings in power plans, or you put the system directly into Hibernate mode from the Lock Button Menu. The system will resume from Hibernate mode by pressing the power button.
Power Management

Configuring the Power Button

The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the computer in to either Sleep or Hibernate. In Sleep, the LED will blink green. In Hibernate the LED will be off (battery) or orange (AC/DC adapter). If only the display is turned off, the LED will remain green.

Password Protection

It is recommended that you enable a password on wake up in order to protect your data.

However you can disable this setting from the Power Options menu by clicking Require a password on wakeup in the left menu, and selecting the options (click Change settings that are currently unavailable).

Figure 3 - 4
Power Options Define Power Buttons
Battery Information

Please follow these simple guidelines to get the best use out of your battery.

Battery Power

Your computer’s battery power is dependent upon many factors, including the programs you are running, and peripheral devices attached. You can set actions to be taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from power plan Advanced Settings (see Figure 3 - 1 on page 3 - 4).

Click the battery icon in the taskbar to see the current battery level and charge status.

Low Battery Warning

When the battery is critically low, immediately connect the AC/DC adapter to the computer or save your work, otherwise, the unsaved data will be lost when the power is depleted.

Figure 3 - 5
Battery Icon (Taskbar) & Battery Advanced Settings
Conserving Battery Power

- Use a **power plan** that conserves power (e.g. **Power saver**), however note that this may have an affect on computer performance.
- Lower the brightness level of the LCD display. The system will decrease LCD brightness slightly to save power when it is not powered by the AC/DC adapter.
- Reduce the amount of time before the display is turned off.
- Close wireless, Bluetooth, modem or communication applications when they are not being used.
- Disconnect/remove any unnecessary external devices e.g. USB devices, ExpressCards etc.

**Windows Mobility Center**

The **Windows Mobility Center** control panel provides an easy point of access for information on battery status, power plans used and wireless device status etc.

*Figure 3 - 6 Windows Mobility Center*
Battery Life

Battery life may be shortened through improper maintenance. To optimize the life and improve its performance, fully discharge and recharge the battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason see “Removing the Battery” on page 6 - 3.

New Battery

Always completely discharge, then fully charge, a new battery (see “Battery FAQ” on page 3 - 13 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter

The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical outlet. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indicators” on page 1 - 7 for information on the battery charge status, and to “Battery Information” on page 3 - 9 for more information on how to maintain and properly recharge the battery pack.)
Proper handling of the Battery Pack

- DO NOT disassemble the battery pack under any circumstances
- DO NOT expose the battery to fire or high temperatures, it may explode
- DO NOT connect the metal terminals (+, -) to each other

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being dropped), or any unusual smells emanating from the notebook battery, shut your computer down immediately and contact your service center. If the battery has been dropped we do not recommend using it any further, as even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire. It is recommended that you replace your computer battery every two years.

Caution

Danger of explosion if battery is incorrectly replaced.

Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.
Battery FAQ

How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer even if a message indicates the battery is critically low, just let the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.
3. Click Change plan settings (after saving it) and click Change advanced power settings.

Figure 3 - 7
Power Plan Create
Power Management

4. Scroll down to **Battery** and click + to expand the battery options.
5. Choose the options below (click **Yes** if a warning appears):

- Low battery levels = 0%
- Critical battery Levels = 0%
- Low battery action = Do Nothing
- Critical battery action (On battery) = Shut Down
- Critical battery action (Plugged in) = Do Nothing

*Figure 3 - 8  
Power Options  
Advanced Settings - Battery*
Power Management

**How do I fully charge the battery?**
When charging the battery, don’t stop until the LED charging indicator light changes from orange to green.

**How do I maintain the battery?**
Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.
Chapter 4: Drivers & Utilities

This chapter deals with installing the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems. The system takes advantage of some newer hardware components for which the latest versions of most available operating systems haven’t built in drivers and utilities. Thus, some of the system components won’t be auto-configured with an appropriate driver or utility during operating system installation. Instead, you need to manually install some system-required drivers and utilities.

RAID Setup

Note that setting up the RAID system and installing the driver for Windows needs to be done prior to installing the Windows OS, and therefore before installing the other drivers listed here (see “Setting Up SATA RAID” on page 7 - 16).

What to Install

The Device Drivers & Utilities + User’s Manual CD-ROM (Win Vista OR WinXP) contains the drivers and utilities necessary for the proper operation of the computer. There will be two CDs provided; one will contain drivers for Windows Vista, the other will contain drivers for Windows XP (make sure you install the appropriate drivers for your system).

Table 4 - 1, on page 4 - 3 lists what you need to install and it is very important that the drivers are installed in the order indicated (see “Driver Installation” on page D - 21 for Windows XP information).

Module Driver Installation

The procedures for installing drivers for the WLAN, PC Camera, Bluetooth, TV Tuner and RAID modules are provided in “Modules” on page 7 - 1. Only install drivers for modules included in your purchase option.
Driver Installation

Insert the Device Drivers & Utilities + User’s Manual CD-ROM and click Install Drivers (button) > Yes, or Optional (button) > Yes, to access the Optional driver menu.

If you wish to install the drivers manually see page 4 - 3.

1. Check the driver installation order from Table 4 - 1, on page 4 - 3 (the drivers must be installed in this order) which is the same as that listed in the Drivers Installer menu below.
2. Click to select the driver you wish to install, after installing each driver it will become grayed out (if you need to reinstall any driver, click the Unlock button).
3. Follow the instructions for each individual driver installation procedure as listed on the following pages.

Figure 4 - 1 - Drivers Installer Screen 1

Figure 4 - 2 - Drivers Installer Screen 2
Manual Driver Installation

If you wish to install the drivers manually, click the Exit button to quit the Drivers Installer application, and then browse to the executable file in the location listed in the table below and follow the installation procedure for each driver. Note that X is the drive letter assigned to the CD/DVD-ROM drive.

<table>
<thead>
<tr>
<th>Driver</th>
<th>Page</th>
<th>Driver Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video (VGA)</td>
<td>Page 4 - 5</td>
<td>Vista 64bit: X:\Drivers\01VGA\Nvidia\64bit\setup.exe</td>
</tr>
<tr>
<td>Audio</td>
<td>Page 4 - 5</td>
<td>Vista 64bit: X:\Drivers\02Audio\Setup.exe</td>
</tr>
<tr>
<td>Modem</td>
<td>Page 4 - 5</td>
<td>Vista 64bit: X:\Drivers\03Modem\64bit\Setup64.exe</td>
</tr>
<tr>
<td>TouchPad</td>
<td>Page 4 - 6</td>
<td>Vista 64bit: X:\Drivers\05TouchPad\Elantech\64bit\setup.exe</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Vista 64bit: X:\Drivers\05TouchPad\Synaptics\64bit\setup.exe</td>
</tr>
<tr>
<td>Card Reader/ExpressCard</td>
<td>Page 4 - 6</td>
<td>Vista 64bit: X:\Drivers\06PCMCIA\64bit\setup.exe</td>
</tr>
<tr>
<td>Hot Key Utility</td>
<td>Page 4 - 6</td>
<td>Vista 64bit: X:\Drivers\07Ap-key\1AP.exe</td>
</tr>
<tr>
<td>Wireless LAN</td>
<td>Page 7 - 2</td>
<td>Vista 64bit: X:\Others\01WLAN\Intel\ProDiFX.exe</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Vista 64bit: X:\Others\01WLAN\AzureW\setup.exe</td>
</tr>
<tr>
<td>PC Camera</td>
<td>Page 7 - 7</td>
<td>Vista 64bit: X:\Others\02Camera\64bit\setup.exe</td>
</tr>
<tr>
<td>Bluetooth</td>
<td>Page 7 - 12</td>
<td>Vista 64bit: X:\Others\03Bluetooth\setup.exe</td>
</tr>
<tr>
<td>TV Tuner</td>
<td>Page 7 - 14</td>
<td>Supplied on Separate CD</td>
</tr>
</tbody>
</table>

Table 4 - 1 - Driver Installation and Location
Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it may be necessary to uninstall the original driver. To do this go to the Control Panel in the Windows OS and double-click the Programs and Features icon (Programs > Uninstall a program). Click to select the driver (if it is not listed see below) and click Uninstall, and then follow the on screen prompts (it may be necessary to restart the computer). Reinstall the driver as outlined in this chapter.

If the driver is not listed in the Programs and Features menu:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click Device Manager (Hardware and Sound > Device Manager).
3. Double-click the device you wish to update/reinstall the driver for (you may need to click “+” to expand the selection).
4. Click Driver (tab) and click the Update Driver or Uninstall button and follow the on screen prompts.

User Account Control (Win Vista)

If a User Account Control prompt appears as part of the driver installation procedure, click Continue or Allow, and follow the installation procedure as directed.

Windows Security Message

If you receive a Windows security message as part of the driver installation process. Just click “Install this driver software anyway” or Install to continue the installation procedure.

You will receive this message in cases where the driver has been released after the version of Windows you are currently using. All the drivers provided will have already received certification for Windows.

New Hardware Found

If you see the message “New Hardware Found” (Found New Hardware Wizard) during the installation procedure (other than when outlined in the driver install procedure), click Cancel to close the window, and follow the installation procedure.
Driver Installation Procedure

Chipset
This driver is included in the Windows Vista OS and therefore does not need to be installed from the CD.

Video (VGA)
1. Click 2.Install Video Driver > Yes.
2. Click Next (click “Install this driver software anyway” if asked if you want to continue).
3. Click Finish to restart the computer.

Audio
1. Click 3. Install Audio Driver > Yes.
2. Click Next.
3. Click Finish to restart the computer.

Modem
1. Click 4.Install Modem Driver > Yes.
2. Click OK > OK.
3. The modem is now ready for configuration.

Modem Country Selection
Go to the Phone and Modem Options control panel (Hardware and Sound) and make sure the modem country selection is appropriate for you.

LAN
This driver is included in the Windows Vista OS and therefore does not need to be installed from the CD.
Drivers & Utilities

TouchPad
1. Click 6. Install Touchpad Driver > Yes.
2. Click Next > Finish.
3. Click Restart Now to restart the computer.
4. You may then configure your TouchPad as outlined in “TouchPad and Buttons/Mouse” on page 2 - 9.

Card Reader/ExpressCard
1. Click 7. Install PCMCIA Driver > Yes.
2. Click Next.
3. Click the button to accept the license, and then click Next.
4. Click Finish.

Hot Key Utility
1. Click 8. Install Hotkey Utility > Yes.
2. Click Next.
3. Click Finish to restart your computer.
4. See configuration instructions for the Application Hot Key on page 2 - 8.

Optional Drivers
See the pages indicated for the driver installation procedures for any modules included in your purchase option.

Figure 4 - 3 - Optional Drivers Installer Screen
Wireless LAN
See the appropriate install procedure for your WLAN module in “Intel WLAN Driver Installation” on page 7 - 2/“802.11 b/g WLAN Driver Installation” on page 7 - 2.

PC Camera
See the install procedure in “PC Camera Driver Installation” on page 7 - 7.

Bluetooth
See the install procedure in “Bluetooth Driver Installation” on page 7 - 12.

TV Tuner
See the install procedure in “Mini-PCI TV Tuner Module” on page 7 - 14.
Chapter 5: BIOS Utilities

Overview

This chapter gives a brief introduction to the computer’s built-in software:

**Diagnostics:** The POST (Power-On Self Test)

**Configuration:** The Setup utility

If your computer has never been set up, or you are making important changes to the system (e.g. hard disk setup), then you should review this chapter first and note the original settings found in Setup. Even if you are a beginner, keep a record of the settings you find and any changes you make. This information could be useful if your system ever needs servicing.

There is one general rule: *Don’t make any changes unless you are sure of what you are doing.* Many of the settings are required by the system, and changing them could cause it to become unstable or worse. If you have any doubts, consult your service representative.

---

**Warning**
Incorrect settings can cause your system to malfunction. To correct mistakes, return to Setup and restore the Setup Defaults with <F9>.
The Power-On Self Test (POST)

Each time you turn on the computer, the system takes a few seconds to conduct a POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there is a problem that prevents the system from booting, it will display a system summary and prompt you to run Setup.

If there are no problems, the Setup prompt will disappear and the system will load the operating system. Once that starts, you can’t get into Setup without rebooting.

POST Screen
1. BIOS information
2. CPU type
3. Memory status
4. Enter Setup prompt appears only during POST

Note: The POST screen as pictured is for guideline purposes only.

Figure 5 - 1
POST Screen

Phoenix TrustedCore™ NB
Copyright 1985-2005 Phoenix Technologies Ltd.
All Rights Reserved
BIOS Revision: 1.01.06
KBC/EC Revision: 1.00.04

CPU = 1 Processor Detected, Cores per Processor = 2
Intel® Core(TM)2 CPU T7200 @ 2.00GHz
1024M System RAM Passed
4096 KB L2 Cache
System BIOS shadowed
Video BIOS shadowed
Fixed Disk 0: TOSHIBA MK6034GEX
ATAPI CD-ROM: PIONEER DVD-RW DVR-K16RS
Mouse initialized

Press <F2> to enter SETUP
Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong with your system. Take the computer to your service representative or authorized service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the problem (make a note of this message!) followed by the prompt:

- Press <F1> to resume
- <F2> to enter Setup

Press F1 to see if the boot process can continue. It may work, without the correct configuration.

Press F2 to run the Setup program and try to correct the problem. If you still get an error message after you change the setting, or if the “cure” seems even worse, call for help.
The Setup Program

The Phoenix Setup program tells the system how to configure itself and manage basic features and subsystems (e.g. port configuration).

Entering Setup

To enter Setup, turn on the computer and press F2 during the POST. The prompt (Press F2 to Enter Setup) seen in Figure 5 - 1 on page 5 - 2 is usually present for a few seconds after you turn on the system. If you get a “Keyboard Error”, (usually because you pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and then hold down F2 when prompted. The Setup main menu will appear.
Setup Screens
The following pages contain additional advice on portions of the Setup.

Along the top of the screen is a menu bar with five (5) menu headings. When you select a heading, a new screen appears. Scroll through the features listed on each screen to make changes to Setup.

Instructions on how to navigate each screen are in the box along the bottom of the screen. If these tools are confusing, press F1 to call up a General Help screen, and then use the arrow keys to scroll up or down the page.

The Item Specific Help on the right side of each screen explains the highlighted item and has useful messages about its options.

If you see an arrow ▶ next to an item, press Enter to go to a sub-menu on that subject. The sub-menu screen that appears has a similar layout, but the Enter key may execute a command.
System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., 00 = midnight; 13 = 1 pm). If you can change the date and time settings in your operating system, you will also change these settings. Some applications may also alter data files to reflect these changes.
IDE Channel 0/1 Master/Slave (Main Menu)
Pressing **Enter** here opens the sub-menu to show the configuration of hard disks and CD/DVD device(s) on the computer’s IDE Channels. Use the **Auto** (Type:) setting to have the items configured automatically for you.

Installed Memory (Main Menu)
This item contains information on the system memory, and is not user configurable. The system will auto detect the amount of memory installed.

The **Main** menu also contains information on your video card and video BIOS version.
**Figure 5 - 3**
Advanced Menu

**PhoenixBIOS Setup Utility**

<table>
<thead>
<tr>
<th>Main</th>
<th>Advanced</th>
<th>Security</th>
<th>Power</th>
<th>Boot</th>
<th>Exit</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1 Help</td>
<td>↑↓ Select Item</td>
<td>-/+ Change Values</td>
<td>F9 Setup Defaults</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Esc Exit</td>
<td>Select Menu</td>
<td>Enter</td>
<td>Select Sub-Menu</td>
<td>F10 Save and Exit</td>
<td></td>
</tr>
</tbody>
</table>

**Advanced Chipset Control**

- Reset Configuration Data: [No]
- Legacy USB Support: [Enabled]
- Boot-time Diagnostic Screen: [Enabled]
- Power on Boot Beep: [Disabled]
- Battery Low Alarm Beep: [Enabled]

Select options for Advanced Chipset features.
Advanced Chipset Control (Advanced Menu)
Pressing Enter here will access the sub-menus which allow you to adjust advanced CPU controls. You can also enable/disable the SATA RAID function (see “Setting Up SATA RAID” on page 7 - 16), and the PXE OPROM (network boot) option.

Figure 5 - 4
Advanced Chipset Control Menu

<table>
<thead>
<tr>
<th>Advanced Chipset Control</th>
<th>Item Specific Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Core Multi-Processing:</td>
<td>[Enabled]</td>
</tr>
<tr>
<td>Processor Power Management:</td>
<td>[Enabled]</td>
</tr>
<tr>
<td>Enhanced C-States Enable:</td>
<td>[Enabled]</td>
</tr>
<tr>
<td>SATA RAID Function:</td>
<td>[Enabled]</td>
</tr>
<tr>
<td>PXE OPROM:</td>
<td>[Disabled]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>F1</th>
<th>Help</th>
<th>↑↓</th>
<th>Select Item</th>
<th>-/+</th>
<th>Change Values</th>
<th>F9</th>
<th>Setup Defaults</th>
</tr>
</thead>
<tbody>
<tr>
<td>Esc</td>
<td>Exit</td>
<td>←→</td>
<td>Select Menu</td>
<td>Enter</td>
<td>Select ▶Sub-Menu</td>
<td>F10</td>
<td>Save and Exit</td>
</tr>
</tbody>
</table>
National 381 SIO Control Sub-Menu (Advanced Menu)
The sub-menus under this item allow you to enable/disable the Serial port A (Serial Mouse), and FIR (Infrared) transceiver.

Reset Configuration Data: (Advanced Menu)
This item is set to No as default. You can change the setting to Yes if you have installed a new add-on which has reconfigured the system, resulting in such a serious system conflict that the operating system is unable to boot.

Legacy USB Support: (Advanced Menu)
Use this menu item to enable/disable the support for Legacy Universal Serial Bus.

Boot-time Diagnostic Screen: (Advanced Menu)
Use this menu item to enable/disable the Boot-time Diagnostic Screen (or POST screen - see “The Power-On Self Test (POST)” on page 5 - 2).

Power On Boot Beep: (Advanced Menu)
Use this menu to enable/disable the single beep sound at the end of the POST. This item is “Disabled” by default.

Battery Low Alarm Beep: (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.
Security Menu

You can set a password for access to the Setup utility. This will not affect access to the computer OS, (only the Setup utility) unless you choose to set a Password on Boot (see over).
Password on boot: (Security Menu)
Specify whether or not a password should be entered to boot the computer. If “Enabled” is selected, only users who enter a correct password can boot the system (see the warning in the sidebar). The default setting is “Disabled”.

Note: To clear existing passwords press Enter and type the existing password, then press Enter for the new password (without typing any password entry) and Enter again to confirm the password clearance.

Fixed disk boot sector: (Security Menu)
If you choose “Write Protect” this will protect against viruses being written to the hard disk boot sector (this is not a substitute for installing an anti-virus program - see “Viruses” on page 8-4).
When you turn the computer on it will look for an operating system (e.g. *Windows XP*) from the devices listed in this menu, and **in this priority order**. If it cannot find the operating system on that device, it will try to load it from the next device in the order specified in the **Boot priority order**. Item specific help on the right is available to help you move devices up and down the order.
## Exit Menu

Choosing to **Discard Changes**, or **Exit Discarding Changes**, will wipe out any changes you have made to the **Setup**. You can also choose to restore the original **Setup** defaults that will return the **Setup** to its original state, and erase any previous changes you have made in a previous session.

---

### Figure 5 - 7
**Exit Menu**

<table>
<thead>
<tr>
<th>PhoenixBIOS Setup Utility</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Main</strong></td>
</tr>
<tr>
<td><strong>Exit Saving Changes</strong></td>
</tr>
</tbody>
</table>

| **F1** | **Help** | **↑↓** | **Select Item** | **→/+** | **Change Values** | **F9** | **Setup Defaults** |
| **Esc** | **Exit** | **←→** | **Select Menu** | **Enter** | **Execute Command** | **F10** | **Save and Exit** |

**Item Specific Help**

Exit System Setup and save your changes to CMOS.
Chapter 6: Upgrading The Computer

Overview

This chapter contains information on upgrading the computer. Follow the steps outlined to make the desired upgrades. If you have any trouble or problems you can contact your service representative for further help. Before you begin you will need:

• A small crosshead or Phillips screwdriver
• A small regular slotted (flathead) screwdriver
• An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic wrist strap to ground yourself because static electricity may damage the components.

The chapter includes:

• Removing the Battery
• Upgrading the Hard Disk Drive(s)
• Upgrading the System Memory (RAM)
• Upgrading the Optical (CD/DVD) Device(s)

Please make sure that you review each procedure before you perform it.

Warranty Warning

Please check with your service representative before undertaking any upgrade procedures to find out if this will VOID your warranty.
Upgrading The Computer

When Not to Upgrade
These procedures involve opening the system’s case, adding and sometimes replacing parts. You should **not** perform any of these upgrades if:

- Your system is still under warranty or a service contract
- You don’t have all the necessary equipment
- You’re not in the correct environment
- You doubt your abilities

Under any of these conditions, contact your service representative to purchase or replace the component(s).

Power Safety Warning
Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines). It is advisable to also remove your battery in order to prevent accidentally turning the machine on.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and screw(s) before turning the computer on.

Upgrading the Processor
If you want to upgrade your computer by replacing the existing processor with a faster/new one you will need to contact your customer service representative. We recommend that you do not do this yourself, since if it is done incorrectly you may damage the processor or mainboard.
Removing the Battery

If you are confident in undertaking upgrade procedures yourself, for safety reasons it is best to remove the battery.

1. Turn the computer off, turn it over and remove the battery.
2. Slide latch 1 towards the unlock symbol and hold it in place, and lift the battery up and out of the battery bay.

Warranty Warning

Please check with your service representative before undertaking any upgrade procedures to find out if this will VOID your warranty.

Figure 6 - 1
Battery Removal
Upgrading the Hard Disk Drive(s)

The hard disk drive(s) can be taken out to accommodate other 2.5" serial (SATA) hard disk drives with a height of 9.5mm (h) (see “Storage Options” on page C - 4). Follow your operating system’s installation instructions, and install all necessary drivers and utilities (as outlined in “Drivers & Utilities” on page 4 - 1), when setting up a new hard disk.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screws 1 - 11.
3. Remove the bay cover 12.

---

**HDD System Warning**

New HDD’s are blank. Before you begin make sure:

- You have backed up any data you want to keep from your old HDD.
- You have all the CD-ROMs and FDDs required to install your operating system and programs.
- If you have access to the internet, download the latest application and hardware driver updates for the operating system you plan to install. Copy these to a removable medium.
4. Remove screws 14 - 17 and lift the bracket up from the hard disk.
5. Slide the hard disk in the direction of the arrow 18.
6. Remove the hard disk 19.
7. Insert the new hard disk into the computer.
8. Re-Insert the bracket and insert screws 14 - 17.

Figure 6 - 3
HDD Removal
Upgrading the System Memory (RAM)

The computer has two memory sockets for 200 pin Small Outline Dual In-line (SO-DIMM) DDR II (DDR2) type memory modules (see “Memory” on page C - 2). The total memory size is automatically detected by the POST routine once you turn on your computer.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screws 1 - 11.
3. Remove the bay cover 12.
4. Gently pull the two release latches (13 & 14) on the sides of the memory socket in the direction indicated by the arrows in Figure 6 - 5.

![Figure 6 - 5 RAM Module Release](image)

5. The RAM module 15 will pop-up, and you can remove it.

![Figure 6 - 6 RAM Module Removal](image)

6. Pull the latches to release the second module if necessary.

Contact Warning

Be careful not to touch the metal pins on the module’s connecting edge. Even the cleanest hands have oils which can attract particles, and degrade the module’s performance.
7. Insert a new module holding it at about a 30° angle and fit the connectors firmly into the memory socket.
8. The module's pin alignment will allow it to only fit one way. Make sure the module is seated as far into the socket as it will go. DO NOT FORCE the module; it should fit without much pressure.
9. Press the module in and down towards the mainboard until the socket levers click into place to secure the module.
10. Replace the cover and screws (see Figure 6 - 4).
11. Restart the computer to allow the BIOS will register the new memory configuration as it starts up.
Upgrading the Optical (CD/DVD) Device(s)

1. Turn the computer off, turn it over and remove the battery.
2. Slide the latch 1 towards the unlock symbol and hold it in place.
3. Slide latch 2 (while still holding latch 1 in place) in the direction indicated by the arrow in order to push the device out of the computer.

Figure 6 - 7
Removing the CD/DVD Device(s)
Upgrading The Computer
Chapter 7: Modules

Overview
This chapter contains the information on the various modules (some of which are optional) which may come with your computer, depending on the configuration purchased. If you are unsure please contact your service representative.

The chapter includes information on the following:

- Wireless LAN Module
- PC Camera Module
- Bluetooth Module
- Mini-PCI TV Tuner Module
- Setting Up SATA RAID
Wireless LAN Module

If you have included an Intel PRO/Wireless 3945ABG (802.11a/b/g) PCIe WLAN module or 802.11 b/g USB WLAN module in your purchase option, make sure that the Wireless LAN module is on before installing the driver. Use the Fn + F11 key combination (see Table 1 - 4, on page 1 - 9) to toggle power to the Wireless LAN module (when the WLAN module is on, the LED will be green). Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

Intel WLAN Driver Installation
1. Make sure the module is powered on, and then insert the Device Drivers & Utilities + User’s Manual CD-ROM into the CD/DVD drive.
2. Click Optional, and then click 1.Wireless Lan > Yes.

802.11 b/g WLAN Driver Installation
1. Make sure the module is powered on, and then insert the Device Drivers & Utilities + User’s Manual CD-ROM into the CD/DVD drive.
2. Click Optional, and then click 1.Wireless Lan > Yes.
3. Click 1.Install WLAN Driver > Yes.
4. Click Finish to complete the installation.

Note: The operating system is the default setting for Wireless LAN control in Windows Vista (see overleaf).
Connecting to a Wireless Network
Make sure the Wireless LAN module is turned on.

1. Click the taskbar wireless icon , and then click Connect to a network (or right-click the icon , and then click Connect to a network).

2. In the Show list, click to choose Wireless from the drop-down menu.
3. A list of currently available networks will appear.

You can also use the Network and Sharing Center control panel in Windows (Network and Internet) to connect to any available wireless networks.
4. Click a network, and then click **Connect**.
5. If you do not see a network you want to connect to, click **Set up a connection or network** (a list of options will appear allowing manual searching, and creating a new network).

6. Move the cursor over the taskbar icon to see the connection status (see below).
7. To disconnect from the wireless network you can click the taskbar wireless icon, and then select **Connect or disconnect** to access the network menu, and click Disconnect (or **right-click** the icon, and then click **Disconnect from**).

Security Enabled Networks

You should try to make sure that any network you are connecting to is a secure network.

Connecting to unsecure networks may allow unauthorized access to your computer, documents, websites and files etc.

**Figure 7 - 5**

Disconnecting
Windows Mobility Center

The Windows Mobility Center control panel provides an easy point of access for information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click Windows Mobility Center (Mobile PC).
3. Click the button to Turn wireless off/on, or click the icon to access the network menu.

Figure 7 - 6
Windows Mobility Center
PC Camera Module

If you have included the PC Camera module in your purchase option, you will have the appropriate software provided on the Device Drivers & Utilities + User’s Manual CD-ROM.

Before installing the driver, make sure the PC Camera is on. Use the Fn + F10 key combination (see Table 1 - 4, on page 1 - 9) to toggle power to the PC Camera module (when the PC Camera module is on, the LED will be green). Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

PC Camera Driver Installation

1. Make sure the module is powered on, and then insert the Device Drivers & Utilities + User’s Manual CD-ROM into the CD/DVD drive (click Cancel if you see a “New Hardware Found” message).
2. Click Optional > Yes, and then click 2.PC Camera, Web cam > Yes.
3. Choose the language you prefer and click Next.
4. Click Next > Install.
5. Click Finish to restart the computer.
6. Run the BisonCap application program from the shortcut on the desktop, or from the BisonCam item in the Start > Programs/All Programs menu (if the hardware is turned off use the Fn + F10 key combination to turn it on again).
PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Microphone (Realtek High Definition Audio) and make sure the item is not disabled.
5. Double-click Microphone (or select Properties from the right-click menu).
6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to the level required.
7. Click OK and close the control panels.
8. Run the BisonCap application program from the Start > Programs/All Programs > BisonCam menu.
9. Go to the Devices menu heading and select Microphone (Realtek).... (it should have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick alongside it).
Figure 7 - 7
Audio Setup for PC Camera

Right-click

PC Camera Module 7 - 9
**BisonCap**

*BisonCap* is a video viewer useful for general purpose video viewing and testing, and can capture video files to .avi format.

1. Run the *BisonCap* program from the Start > Programs/All Programs > Bison-Cam menu (it is recommended that you set the capture file before the capture process - see Set Capture File below).
2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera Audio Setup” on page 7 - 8) and select Start Capture.
3. On the first run of the program (if you have not set the captured file) you will be asked to choose a file name and size (see the sidebar - Pre-Allocating File Space) for the captured file. Click Start Capture again.
4. Click OK to start capturing the video, and press Esc to stop the capture.
5. If you wish to, you may go to the File menu and select Save Captured Video As..., choose a file name and location, and then click Open (you can view the file using the Windows Media Player).

**Set Capture File**

In the *BisonCap* program you will only be asked to set the capture file name on the first run of the program. When you run the program the next time the file will automatically be overwritten with the newly captured file. To avoid overwriting files you can go to the Set Capture File.. option in the File menu, and set the file name and location before capture. Set the name and location then click Open (you can choose Cancel to ignore the file size if prompted).
Eliminating Screen Flicker
If you find that the video screen in the BisonCap program is flickering, you can try to adjust the setting in the Video Capture Filter options.

1. Run the BisonCap program.
2. Go to Options and scroll down to select “Video Capture Filter...”.
3. Click either 50Hz or 60Hz under Frequency in Property Page (tab).
Bluetooth Module

The **optional** Bluetooth module allows you to connect your computer to Bluetooth enabled devices such as other computers, desktop computers, mobile phones, printers, digital cameras, PDAs, headsets etc. using a short-range radio frequency.

Make sure that the Bluetooth module is on. Use the **Fn + F12 key combination** (see *Table 1 - 4, on page 1 - 9*) to toggle power to the **Bluetooth module** (when the Bluetooth module is on, the LED will be green).

**Bluetooth Driver Installation**

1. Make sure the module is powered on, and then insert the **Device Drivers & Utilities + User’s Manual CD-ROM** into the CD/DVD drive.
2. Click **Install Option Drivers** (button).
3. Click **3.Install Bluetooth Driver > Yes**.
4. Choose the language you prefer, and click **OK > Next**.
5. Click the button to accept the license agreement, and then click **Next**.
6. Click **Next > Install**.
7. Click **Finish**, and the **BlueSoleil** icon will appear on the desktop.
8. You can configure the settings at any time by going to the **IVT Corporation BlueSoleil - Main Window** (*Start > Programs/All Programs > IVT BlueSoleil > BlueSoleil*), or by clicking the desktop icon.

**Wireless Device Operation Aboard Aircraft**

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.
User Guides & Help

View the BlueSoleil User Guides from the Help Menu (or press the F1 key) in the IVT Corporation BlueSoleil - Main Window control panel.

Click the Help menu and select Contents and Index.

Look through Getting Started or select the appropriate User Guide from the Contents menu.

Figure 7 - 9
BlueSoleil Main Window & Help
Mini-PCI TV Tuner Module

If your purchase includes the analog Mini-PCI TV Tuner module (for *Windows Vista Home Premium* or *Ultimate Editions*) you will be able to watch TV, play music CDs, video conference and capture still images and video on your PC.

The **YUAN PVR MPC622** TV Tuner module comes with a remote control unit, and a CD containing driver software for *Windows Vista Home Premium Edition* or *Ultimate Edition*.

The CATV-In jack will only be enabled when the TV Tuner module is installed. Make sure you install any software before connecting the TV antenna. Point the remote at the consumer **IR transceiver** to change channels etc.

---

**CATV Cable Safety**

Make sure that your CATV system installer has connected the Coaxial cable shield to the grounding system of the building, as close to the point of cable entry as practical.

**TV Antenna**

The TV antenna supplied with any TV Tuner module is intended for indoor use only. Please do not use your TV Tuner module outdoors.

---

*Figure 7 - 10  
TV Tuner Ports*

1. CATV-In Jack
YUAN PVR Mini-PCI MPC622 TV Tuner Module

If your purchase includes the YUAN PVR MPC622 TV Tuner, then you will need to install the driver as per the instructions below.

Installing the MPC622-64 Driver
1. Insert the driver CD-ROM into the CD/DVD drive.
2. Choose the language you prefer and click Next.
3. Click Next > Next.
4. Click the button to accept the license and click Next > Next > Next > Install.
5. Click Finish > Finish.
7. Run Windows Media Center directly from the Start menu (Start > Programs > Windows Media Center).
Setting Up SATA RAID

If your purchase includes the RAID (Redundant Array of Independent Disks) option, the following pages provide an introduction to configuring your hard disk(s) in RAID mode. You may use your hard disks in combination with Striping (RAID 0) or Mirroring (RAID 1) for either fault tolerance or performance.

Prepare the following before setting up your Serial ATA hard disks in RAID mode:

1. An external USB CD/DVD device drive (the *Microsoft Windows OS CD* should be inserted into this drive).
2. The second hard disk installed in the optional device drive bay (see page 6 - 9).

### Table 7 - 1

<table>
<thead>
<tr>
<th>RAID Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID 0</td>
<td>Identical drives reading and writing data in parallel to <em>increase performance</em>. RAID 0 implements a striped disk array and the data is broken into blocks and each block is written to a separate disk drive.</td>
</tr>
<tr>
<td>RAID 1</td>
<td>Identical drives in a mirrored configuration used to <em>protect data</em>. Should a drive that is part of a mirrored array fail, the mirrored drive (which contains identical data) will handle all the data. When a new replacement drive is installed, data to the new drive is rebuilt from the mirrored drive to restore fault tolerance.</td>
</tr>
</tbody>
</table>
SATA RAID Setup Procedure
1. Start-up your notebook computer and press <F2> to enter the BIOS.
2. Go to the Advanced menu, select "Advanced Chipset Control" and press Enter.
3. Select "SATA RAID Function:" and press Enter, then select "Enabled" and press Enter.
4. Press Esc and go to the Boot menu.
5. Attach the external CD/DVD-ROM drive to one of the notebook computer’s USB ports.
6. Set the external CD/DVD-ROM Drive (make sure the Microsoft Windows OS CD is inserted) as the first device in the boot order from the Boot Device menu.
7. Select Exit Saving Changes from the Exit menu (or press F10 and Enter) and press Enter to exit the BIOS and reboot the computer.
8. Press Ctrl + i to enter RAID configuration menu.

Intel(R) Matrix Storage Manager option ROM v5.0.0.9046 ICH7R
Copyright (C) 2003-04 Intel Corporation. All Rights Reserved.

Array Types
A Mirrored Array (RAID 1) provides full data protection, as data can simply be copied from a healthy disk to a replacement for any failed disk.

A Striped Array (RAID 0) is NOT fault-tolerant. The failure of one drive will result in the loss of all data in the array. It is designed to increase disk performance by spreading the I/O load across the channels and drives.

Figure 7 - 11
Intel(R) Matrix Storage Manager
9. Select **Create RAID Volume** and press Enter.
10. Type the **RAID volume name** and then press Tab or Enter to advance to the next field.
11. Specify (use the up and down arrow keys) the **RAID level** (**RAID 0 or RAID 1** - see Table 7-1, on page 7-16 and sidebar) and then press Tab or Enter to advance to the next field.
12. Press Enter and the system will select the physical disks to use.
13. Press Enter and select (if applicable) the Strip Size (best set to default).
14. Press Enter and select the Capacity size (best set to default).
15. Press Enter to **Create Volume**.
16. Scroll down to **Create Volume** and press Enter to create the volume.
17. Confirm the selection by pressing **Y**.
18. This will now return to the main menu.
19. Select **4. Exit** and press Enter, then press **Y** to exit the RAID configuration menu.
20. As the computer starts up, press a key when you see the message "**Press any key to boot from CD**".
21. Press **Enter** to continue installing the operating system as normal (see your **Windows** documentation if you need help on installing the **Windows** OS).
22. Install the Windows drivers as per **Table 4-1, on page 4-3**.
Chapter 8: Troubleshooting

Overview

Should you have any problems with your computer, before consulting your service representative, you may want to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface. If all else fails, talk to your service representative. You should also make a record of what happened and what remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call your service representative.
Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer appears not to be working.

- **Power** - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, make sure it is actually working. Check the LED Power Indicators (see “LED Indicators” on page 1 - 7) to see the computer’s power status.

- **Connections** - Check all the cables to make sure that there are no loose connections anywhere.

- **Power Savings** - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys configured in your Power Options (see “Configuring the Power Button” on page 3 - 8), the Fn + F4 key combination, or power button to wake-up the system.

- **Brightness** - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the brightness (see Table 1 - 4, on page 1 - 9).

- **Display Choice** - Press Fn + F7 to make sure the system is not set to “external only” display.

- **Boot Drive** - Make sure there are no optical media and/or USB storage devices in any connected drive when you start up your machine (this is a common cause of the message “Invalid system disk - Replace the disk, and then press any key” / “Remove disks or other media. Press any key to restart”).
Backup and General Maintenance

- Always **backup** your important data, and keep copies of your OS and programs safe, but close to hand. Don’t forget to note the **serial numbers** if you are storing them out of their original cases, e.g. in a CD wallet.

- Run **maintenance programs** on your hard disk and OS as often as you can. You may schedule these programs to run at times when you are not using your computer. You can use those that are provided free with your OS, or buy the more powerful dedicated programs to do so.

- Write down your passwords and keep them safe (away from your computer). This is especially important if you choose to use a **Boot** password for the SCU (see *Security Menu* on page 5 - 11).

- Keep copies of vital **settings files** such as network, dialup settings, mail settings etc. (even if just brief notes).

---

**Warranty**

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.
Viruses

- Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm your computer and cause you to lose data. Anti-Virus programs are commercially available and the definitions file updates are usually downloadable directly from the internet.

- Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-mail attachments so take care when opening any attached file. You can configure most Anti-Virus programs to check all e-mail attachments. Note: You should also beware of files from people you know as the virus may have infected an address book and been automatically forwarded without the person’s knowledge.

- Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic information which allows you to startup your computer) handy. You may refer to your OS’s documentation for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at least instructions on how to make one).
Upgrading and Adding New Hardware/Software

- Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are doing, otherwise you will risk severely damaging your system.

- Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what you are doing.

- Read the documentation. We can assume, since you are reading this that you are looking at the computer’s manual, but what about any new peripheral devices you have just purchased? Many problems are caused by the installation of new hardware and/or software. Always refer to the documentation of any new hardware and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

- When installing a new device always make sure the device is powered on, and in many cases you will need to restart the computer. Always check that all the cables are correctly connected.

- Make sure you have installed the drivers for any new hardware you have installed (latest driver files are usually available to download from vendor’s websites).

- Thoroughly check any recent changes you made to your system as these changes may affect one or more system components, or software programs. If possible, go back and undo the change you just made and see if the problem still occurs.
Troubleshooting

• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may be found; **Example** - if your computer has many devices plugged into its ports, and a number of programs running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and removing devices and restarting where necessary) will often find the source of a problem, although this may be time consuming.
## Troubleshooting

### Problems & Possible Solutions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You turned the <strong>power on</strong> but it doesn’t work.</td>
<td><em>Battery missing / incorrectly installed.</em> Check the battery bay, make sure the battery is present and seated properly (the design of the battery only allows it to go in one way). Make sure there’s nothing interfering with the battery contacts.</td>
</tr>
<tr>
<td>The <strong>Battery LED power indicator</strong> is blinking orange.</td>
<td><strong>Low Battery.</strong> Plug in the AC power source. If the computer doesn’t start up immediately, turn it off then on again.</td>
</tr>
<tr>
<td>You are losing <strong>battery power</strong> too quickly.</td>
<td><strong>The system is using too much power.</strong> If your OS has a <strong>Power Options</strong> scheme (see “<strong>Power Plans</strong>” on page 3 - 4/“<strong>Power Schemes</strong>” on page D - 13) check its settings. You may also be using an PC Card/ExpressCard device/USB device/external device that is drawing a lot of power.</td>
</tr>
<tr>
<td>Actual <strong>battery operating time</strong> is shorter than expected.</td>
<td><strong>The battery has not been fully discharged before being recharged.</strong> Make sure the battery is fully discharged and recharge it completely before reusing (see “<strong>Battery Information</strong>” on page 3 - 9/“<strong>Battery Information</strong>” on page D - 17). Check the settings of any active power plan (see “<strong>Power Plans</strong>” on page 3 - 4/“<strong>Power Schemes</strong>” on page D - 13). <strong>A peripheral device/USB device/PC Card is consuming a lot of power.</strong> Turn off/remove the unused device to save power.</td>
</tr>
</tbody>
</table>
### Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>The computer feels too hot.</strong></td>
<td>Make sure the computer is properly ventilated and the vents/fan intakes are not blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make sure the computer isn’t sitting on a thermal surface (see “Overheating” on page 1 - 12). Make sure you're using the correct adapter. Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the vents/fan intakes to be blocked.</td>
</tr>
<tr>
<td><strong>Nothing appears on screen.</strong></td>
<td>The system is in a power saving mode. Toggle the Fn + F4 (see “Configuring the Power Button” on page 3 - 8/“Configuring the Power Button” on page D - 16). The screen controls need to be adjusted. Toggle the screen control Fn + F8/F9 key combinations. If you’re connected to an external monitor, make sure it's plugged in and turned on. You should also check the monitor’s own brightness and contrast controls. The computer is set for a different display. Toggle the screen display key Fn + F7 combination. If an external monitor is connected, turn it on. The screen saver is activated. Press any key or touch the TouchPad.</td>
</tr>
<tr>
<td><strong>No image appears on the external monitor I have plugged in and powered on.</strong></td>
<td>You haven’t installed the video driver and configured it appropriately from the Control Panel. See “NVIDIA Video Driver Controls” on page B - 1/“Video Features” on page D - 5 for instructions on installing and configuring the video driver.</td>
</tr>
<tr>
<td><strong>You forget the boot password.</strong></td>
<td>If you forget the password, you may have to discharge the battery of the CMOS. Contact your service representative for help.</td>
</tr>
<tr>
<td>Problem</td>
<td>Possible Cause - Solution</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>The <strong>sound</strong> cannot be heard or the volume is very low.</td>
<td>The volume might be set too low. Check the volume control in the <em><a href="#">Volume Control Panel</a></em> in the Windows taskbar, or use the key combination Fn + F5 and F6 (see “Audio Features” on page 2-10/“Audio Features” on page D-4) to adjust.</td>
</tr>
<tr>
<td>The <strong>compact disc</strong> cannot be read.</td>
<td>The compact disc is dirty. Clean it with a CD-ROM cleaner kit.</td>
</tr>
<tr>
<td>The <strong>compact disc tray</strong> will not open when there is a disc in the tray.</td>
<td>The compact disc is not correctly placed in the tray. Gently try to remove the disc using the eject hole (see “Loading Discs” on page 2-3).</td>
</tr>
<tr>
<td>The <strong>DVD regional codes</strong> can no longer be changed.</td>
<td>The code has been changed the maximum 5 times. See “DVD Regional Codes” on page 2-5/“DVD Regional Codes” on page D-2.</td>
</tr>
<tr>
<td>The <strong>TouchPad</strong> doesn’t work.</td>
<td>The Touchpad has been disabled. Press the Touchpad toggle (Fn + F1) key combination (make sure you have installed the Touchpad driver).</td>
</tr>
</tbody>
</table>

**Password Warning**

If you choose to set a boot password, **NEVER** forget your password. The consequences of this could be serious. If you cannot remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The system freezes or the screen goes dark.</td>
<td><em>The system’s power saving features have timed-out.</em> Use the AC/DC adapter, press a key on the keyboard, or press the sleep (Fn + F4) key combination, or press the power button if no LEDs are lit.*</td>
</tr>
<tr>
<td>The system never goes into a power saving mode.</td>
<td><em>Power Options features are not enabled.</em> Go to the <em>Windows</em> Power Options menu and enable the features you prefer (see “System Power Options” on page 3 - 6 “System Power Options” on page D - 14). Make sure you have enabled Hibernate mode from the control panel.*</td>
</tr>
<tr>
<td>The Wireless LAN/Bluetooth/PC Camera modules cannot be detected.</td>
<td><em>The modules are off.</em> Check the appropriate LED indicator ( IntelliJ ) to see if the modules are on or off (see “LED Indicators” on page 1 - 7). If the LED indicator is off, then press the appropriate function key combination in order to enable the modules.*</td>
</tr>
<tr>
<td>The Wireless LAN/Bluetooth/PC Camera modules cannot be configured.</td>
<td><em>The driver(s) for the module(s) have not been installed.</em> Make sure you have installed the driver for the appropriate module (see the instructions in Chapter 7 “Modules” for the appropriate module).*</td>
</tr>
<tr>
<td>The PC Camera software displays a black screen when the BisonCap software is run.</td>
<td><em>The software is using the incorrect device.</em> If you have both an optional PC Camera and an optional TV Tuner module present, you will need to select which device to use with the BisonCap program. Go to the Devices menu in the BisonCap program and select the BisonCam, NB Pro device.*</td>
</tr>
</tbody>
</table>

8 - 10 Problems & Possible Solutions
Appendix A: Interface (Ports & Jacks)

Overview
The following chapter will give a quick description of the ports & jacks which allow your computer to communicate with external devices, connect to the internet etc.
## Ports and Jacks

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card Reader</td>
<td>The card reader allows you to use the following digital storage cards:</td>
</tr>
<tr>
<td></td>
<td>MMC (MultiMedia Card)</td>
</tr>
<tr>
<td></td>
<td>SD (Secure Digital)</td>
</tr>
<tr>
<td></td>
<td>MS (Memory Stick)</td>
</tr>
<tr>
<td></td>
<td>MS (Memory Stick Pro)</td>
</tr>
<tr>
<td></td>
<td>RS MMC (requires PC adapter)</td>
</tr>
<tr>
<td></td>
<td>Mini SD (requires PC adapter)</td>
</tr>
<tr>
<td></td>
<td>MS Duo (requires PC adapter)</td>
</tr>
<tr>
<td>TV Antenna Jack</td>
<td>Use this jack to connect a CATV cable if you have included the optional Mini-PCI TV Tuner in your purchase.</td>
</tr>
<tr>
<td>CATV</td>
<td></td>
</tr>
<tr>
<td>Consumer Infrared Transceiver</td>
<td>The consumer infrared transceiver at the front of the computer allows the computer to communicate with the remote control unit supplied with the optional Mini-PCI TV Tuner (see “System Map: Bottom View” on page 1 - 15).</td>
</tr>
<tr>
<td>DC-In Jack</td>
<td>Plug the supplied AC/DC adapter into this jack to power your computer.</td>
</tr>
<tr>
<td>DVI-Out Port</td>
<td>The DVI-Out (Digital Visual Interface) Port allows you to connect an external monitor, or Flat Panel Display, to allow dual video or simultaneous display on the LCD and external monitor/FPD (see “Display Modes Available” on page 1 - 18). If you are using an older type of monitor you will need to use a converter to convert the signal from DVI to VGA.</td>
</tr>
</tbody>
</table>
# Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Headphone-Out Jack</td>
<td><strong>Headphones</strong> or <strong>speakers</strong> may be connected through this jack. <strong>Note:</strong> Set your system’s volume to a reduced level before connecting to this jack.</td>
</tr>
<tr>
<td>Infrared (FIR) Transceiver</td>
<td>The <strong>FIR</strong> (far infrared) transceiver at the front of the computer allows the computer to communicate with similarly equipped devices (see “Configuring the Infrared Settings for FIR” on page 2-11).</td>
</tr>
<tr>
<td>Line-In Jack</td>
<td>The Line-In jack allows you to play audio sources through the computer’s speakers. Note that audio input through Line-in will default to the <strong>mute</strong> setting. To set up your audio sources to play through the Line-in jack go to the <strong>Sounds and Audio Devices</strong> Windows control panel and make sure the Mute box is not ticked.</td>
</tr>
<tr>
<td>Microphone-In Jack</td>
<td>Plug an external microphone in to this jack to record on your computer.</td>
</tr>
<tr>
<td>Mini-IEEE 1394 Port</td>
<td>This allows high-speed connection to various peripheral devices, e.g. external disk drives and digital cameras (see note below).</td>
</tr>
</tbody>
</table>

*IEEE 1394*

The Mini-IEEE 1394 ports only support **SELF POWERED** IEEE 1394 devices.
# Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| RJ-11 Phone Jack         | This port connects to the built-in modem. You may plug the telephone line directly into this RJ-11 telephone connection.  
**Note:** Broadband (e.g. ADSL) modems usually connect to the LAN port. |
| RJ-45 LAN Jack           | This port supports LAN (Network) functions.  
**Note:** Broadband (e.g. ADSL) modems usually connect to the LAN port. |
| S/PDIF-Out Jack          | This S/PDIF (Sony/Philips Digital Interface Format) Out Port allows you to connect your DVD-capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound. |
| Security Lock Slot       | To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be purchased at any computer store. |
| Serial Port              | Connect a serial type mouse to this port.                                                                                                                                               |
| 7-Pin S-Video-Out Jack   | Connect your television to your computer and view DVDs, VCDs or anything else your computer can display.                                                                                     |
USB 2.0/1.1 Ports

These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into the computer, and unplugged from the computer, without the need to turn the system off (if the power rating of your USB device is 500mA or above, make sure you use the power supply which comes with the device).

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB 2.0/1.1 Ports</td>
<td>These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into the computer, and unplugged from the computer, without the need to turn the system off (if the power rating of your USB device is 500mA or above, make sure you use the power supply which comes with the device).</td>
</tr>
</tbody>
</table>
Interface (Ports & Jacks)
Appendix B: NVIDIA Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features” on page 1 - 17.

NVIDIA Video Driver Installation

Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

2. Click Install Drivers (button).
3. Click 2.Install Video Driver > Yes.
4. Click Next (click Install this driver software anyway if asked if you want to continue).
5. Click Finish to restart the computer.

Video Card Options

Note that card types, specifications and drivers are subject to continual updates and changes. Check with your service center for the latest details on video cards supported.

2nd Battery Note

The 2nd battery alone CAN NOT power the system if any of the NVIDIA GeForce video cards are the installed option.
NVIDIA Control Panel

More advanced video configuration options are provided in the NVIDIA Control Panel tab.

1. Open the Display Settings (see page 1 - 18) control panel.
2. Click Advanced Settings (button).
3. Click GeForce Go 7950GTX (tab).
4. Click Start the NVIDIA Control Panel to make any video adjustments.

OR

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click NVIDIA Control Panel (click "Classic View" from the left of the menu if you are in Control Panel Home).

Figure B - 1
NVIDIA GeForce Go Control Panel
The **NVIDIA Control Panel** provides additional video configuration controls and tools which allow quick access to features such as display configuration, 3D Settings and Help menus etc.

![NVIDIA Control Panels](image)

**Navigating the Control Panel**

Navigate through the control panels in much the same way as you would a web page. Click on the headings, menus and highlighted links for information. Use the buttons on the top left to go back, forward etc.

**Figure B - 2**

NVIDIA Control Panels
The **Help** menus provide index and search features, and direct links to the NVIDIA website etc.

*Figure B - 3*  
**Help Menus**
Display Devices

Besides the built-in LCD, you can also use an external monitor/flat panel display or TV as your display device. The following are the display options:

1. The built-in LCD.
2. An external monitor connected to the DVI-Out Port (may require DVI to VGA converter).
3. A flat panel display connected to the DVI-Out Port (may require DVI to VGA converter).
4. A TV connected to the 7-pin S-Video-Out jack.

Monitor and TV Tuner

If you are connecting both a monitor/flat panel display to the DVI-Out Port, and a cable/aerial to the optional TV Tuner module, make sure you attach the cable/aerial to the TV Tuner first, then the monitor.
Attaching Other Displays

Configuring an External Display in Windows Vista
1. Attach your external display to the external monitor port and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the Windows Mobility Center control panel (Mobile PC > Adjust commonly used mobility settings) and click Connect display.
3. Click on any of the buttons to configure the displays to your preferences, or click Display Settings (in the New Display Detected window) to access the control panel.

Figure B - 4
New Display Detected
Configuring an External Display using the NVIDIA Control Panel
Alternatively you can use the NVIDIA control panel to configure any attached displays.
1. Attach your external monitor to the DVI-Out Port (or TV to the 7-pin S-Video-Out jack), and turn it on.
2. Go to NVIDIA Control Panel (see “NVIDIA Control Panel” on page B - 2).
3. Click Display, and then click Change Display configuration.
4. Choose the nView display mode you wish to use (see page B - 8).
5. Select the displays you want to use (if your display is not shown click “My Display is not shown in the list...”), and choose which display is to be the primary display.
6. Click Apply > Yes to save the changes.
Display Modes

Single Display Mode
Only one of your displays is used.

Clone Mode
Clone Mode simply shows an exact copy of the Primary display desktop on the other display(s). This mode will drive multiple displays with the same content.

Dualview Mode
Dualview Mode treats both connected displays as separate devices, and they act as a virtual desktop resulting in a large workspace. When Dualview is enabled, you can drag any icons or windows across to the other display desktop. It is therefore possible to have one program visible in one of the displays, and a different program visible in the other display.
Using New Display Detected to Enable Extended Mode

1. Attach your external display to the external monitor port and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the Windows Mobility Center control panel (Mobile PC > Adjust commonly used mobility settings) and click Connect display.
3. Click to select Show different parts of my desktop on each display (extended).
4. Click Right or Left under Extend your desktop.
5. Click Apply > OK.

Figure B - 6
New Display Detected (Extended)
Using Display Settings to Enable Extended Mode
1. Attach your external monitor to the DVI-Out Port (or TV to the 7-pin S-Video-Out jack), and turn it on.
2. Click Start, and click Control Panel (or point to Settings and click Control Panel).
3. Click Adjust screen resolution under the Appearance and Personalization menu (or double-click Personalization > Display Settings).
4. Click the monitor icon (e.g.  ), and make sure you have checked “Extend the desktop onto this monitor.” and click Apply.

Click the appropriate monitor icon (e.g.  ) to be able to select the option to extend the desktop on to it.

In this example the Primary monitor  is on the left, the secondary display  is on the right.
Enabling TV Display

To display desktop images on a TV, connect the TV to your computer by using an S-Video cable from the TV to the 7-pin S-Video-Out jack at the rear of the computer.

You will need to enable the TV display from the NVIDIA Control Panel as per the instructions on B - 7. The TV will appear as a display option (2. Select the displays you would like to use.) when attached to the 7-pin S-Video-Out jack. Apply the settings, and then click Yes to save the changes.

Detect Displays

To get a full range of display options click “My display is not shown in the list...”.

Figure B - 8
Change Display Configuration (with TV connected)
Changing the TV Signal Format

1. When the TV is selected as a display device, click the home icon to return to the category menu.
2. Click Video and Television, and then click "Change the signal or HD format".
3. Select the TV signal format (the menu allows you to select TV format by country if you are unsure of your TV format).
4. Apply the settings, and then click Yes to save the changes.

Figure B - 9
Change the TV Signal
Appendix C: Specifications

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check with your service center for details.
## Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
</table>
| **Processor Types** | Intel® Core™ Duo Processor  
(478-pin) Micro-FC-PGA Package  
T2300/ T2400/ T2500/ T2600/ T2700  
Intel® Core™ 2 Duo Processor  
(478-pin) Micro-FC-PGA Package  
T7200/ T7400/ T7600 | 65nm (65 Nanometer) Process Technology  
2MB On-die L2 Cache & 667MHz FSB  
1.66/ 1.83/ 2.0/ 2.16/ 2.33 GHz  
65nm (65 Nanometer) Process Technology  
4MB On-die L2 Cache & 667MHz FSB  
2.0/ 2.16/ 2.33 GHz |
<p>| <strong>Core Logic</strong>   | Intel 945GM + ICH7-M DH                                                     |
| <strong>LCD</strong>          | Flat Panel TFT (For One of the Following Options)                           |
|                  | 17&quot; WXGA (1440 * 900) TFT LCD                                               |
|                  | OR                                                                          |
|                  | 17&quot; WSXGA+ (1680 * 1050) TFT LCD                                            |
|                  | OR                                                                          |
|                  | 17&quot; WUXGA (1920 * 1200) TFT LCD                                            |
| <strong>Security</strong>     | Security (Kensington® Type) Lock Slot BIOS Password                         |
| <strong>Memory</strong>       | Two 200 Pin SO-DIMM Sockets Supporting DDRII (DDR2) Up To 667 MHz           |
|                  | 128-bit Wide DDRII (DDR2) Data Channel                                       |
|                  | Memory Expandable up to 4GB (256/ 512/ 1024 MB DDRII Modules)               |
|                  | (Note: Do Not Use Other Module Types)                                       |
| <strong>BIOS</strong>         | One 512KB Flash ROM  Phoenix BIOS                                           |</p>
<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
</table>
| Video Card Options | For Windows XP  
ATI Mobility Radeon X1600 (M56)  
PCI-Express Video Card  
128MB GDDRIII (GDDR3) Video RAM On Board  
PCI Express * 16  
Supports DirectX® 9  
Modular Design  
Supports Hyper Memory  
NVIDIA Quadro FX 2500M (G71GLM-U)  
PCI-Express Video Card  
512MB GDDRIII (GDDR3) Video RAM On Board  
256 bit Memory Interface  
PCI Express * 16  
Fully Supports DirectX® 9  
Supports OpenGL  
Modular Design  
NVIDIA GeForce Go 7900-GTX (G71M-U)  
PCI-Express Video Card  
512MB GDDRIII (GDDR3) Video RAM On Board  
256 bit Memory Interface  
PCI Express * 16  
Fully Supports DirectX® 9  
H.264 Encoding Supported (HD-DVD / BD-DVD Playback)  
Modular Design |
| For Windows XP and Vista  
NVIDIA Quadro FX 2500M (G71GLM-U)  
PCI-Express Video Card  
512MB GDDRIII (GDDR3) Video RAM On Board  
256 bit Memory Interface  
PCI Express * 16  
Fully Supports DirectX® 9  
Supports OpenGL  
Modular Design |

Video Card Options

Note that card types, specifications and drivers are subject to continual updates and changes. Check with your service center for the latest details on video cards supported.
### Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Storage Options</strong></td>
<td>One 2.5&quot; 9.5mm (h) Serial-ATA (SATA) Hard Disk Drive</td>
</tr>
<tr>
<td></td>
<td><strong>One Changeable Device Bay For One of the Following Options:</strong></td>
</tr>
<tr>
<td></td>
<td>For 12.7 mm (h) Optical CD/DVD Device Drive Options (see “Optional” on page C - 7)</td>
</tr>
<tr>
<td></td>
<td>OR</td>
</tr>
<tr>
<td></td>
<td>For Secondary 2.5&quot; 9.5mm (h) Hard Disk Drive (RAID Option in SATA Configuration)</td>
</tr>
<tr>
<td></td>
<td>OR</td>
</tr>
<tr>
<td></td>
<td>For 2nd Battery</td>
</tr>
<tr>
<td><strong>Card Reader</strong></td>
<td>Embedded 7-in-1 Card Reader (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo)</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> MS Duo/ Mini SD/ RS MMC Cards Require a PC Adapter</td>
</tr>
<tr>
<td><strong>Audio</strong></td>
<td>Integrated AZALIA Compliant Interface (HDA)</td>
</tr>
<tr>
<td></td>
<td>3D Stereo Enhanced Sound System</td>
</tr>
<tr>
<td></td>
<td>SRS WOW Surround Sound Technology</td>
</tr>
<tr>
<td></td>
<td>Inside</td>
</tr>
<tr>
<td></td>
<td>Sound-Blaster PRO™ Compatible</td>
</tr>
<tr>
<td></td>
<td>Built-In Standalone Audio &quot;DJ&quot; CD Player</td>
</tr>
<tr>
<td></td>
<td>(Supports MP3 Formats)</td>
</tr>
<tr>
<td></td>
<td>Supports 7.1 CH Audio Output via S/PDIF Output Jack</td>
</tr>
<tr>
<td><strong>Keyboard &amp; Pointing Device</strong></td>
<td>Full Size Winkey Keyboard with Numeric Keypad</td>
</tr>
<tr>
<td></td>
<td>Built-In TouchPad (Scroll Functionality Included)</td>
</tr>
</tbody>
</table>
# Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ExpressCard Slot</strong></td>
<td>ExpressCard/34/54 Slot</td>
</tr>
<tr>
<td><strong>I/O Ports</strong></td>
<td>Four USB 2.0 Ports&lt;br&gt;One Mini-IEEE1394 Port&lt;br&gt;One Serial Port&lt;br&gt;One DVI-Out Port&lt;br&gt;One Headphone/Speaker-Out Jack&lt;br&gt;One Microphone-In Jack&lt;br&gt;One S/PDIF Out Jack&lt;br&gt;One Line-In Jack for Audio Input&lt;br&gt;One Infrared Transceiver</td>
</tr>
<tr>
<td><strong>Communication</strong></td>
<td>Infrared Transceiver&lt;br&gt;Infrared Transfer 1cm ~ 1M Operating Distance&lt;br&gt;IrDA 1.1 / FIR Compliant&lt;br&gt;1GB PCIe Fast Ethernet LAN Module&lt;br&gt;AZALIA MDC 56K V1.5 Modem&lt;br&gt;Intel PRO/Wireless 3945ABG PCIe Wireless LAN Module (Factory Option)&lt;br&gt;802.11 b/g USB Wireless LAN Module (Factory Option)</td>
</tr>
</tbody>
</table>
## Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operating Systems Supported</strong></td>
<td>Windows XP SP2  &lt;br&gt; Windows Vista 64bit  &lt;br&gt; Home Premium/ Business/ Enterprise/ Ultimate</td>
</tr>
<tr>
<td><strong>Power Management</strong></td>
<td>Supports ACPI 2.0  &lt;br&gt; Soft Off by System Power Button  &lt;br&gt; Supports Resume from Alarm</td>
</tr>
<tr>
<td><strong>Power</strong></td>
<td>Full Range AC/DC Adapter – AC in 100 - 240V, 50 - 60Hz DC Output 20V, 6.5A (130 Watts)</td>
</tr>
<tr>
<td><strong>Environmental Spec</strong></td>
<td><strong>Temperature</strong>  &lt;br&gt; Operating: 5°C ~ 35°C  &lt;br&gt; Non-Operating: -20°C ~ 60°C</td>
</tr>
<tr>
<td><strong>Physical Dimensions &amp; Weight</strong></td>
<td>397mm (w) * 294mm (d) * 22 ~ 44mm (h)</td>
</tr>
</tbody>
</table>
### Optional Optical Drive Module Options:
- DVD/CD-RW Combo Drive Module
- DVD-Dual Drive Module
- DVD-Super Multi Drive Module
- Intel PRO/Wireless 3945ABG PCIe Wireless LAN Module *(Factory Option)*
- 802.11 b/g USB Wireless LAN Module *(Factory Option)*
- Easy Changeable 8-Cell Smart Lithium-Ion 4400mAH *Main Battery*
- Easy Changeable 6-Cell Smart Lithium-Ion 3800mAH *2nd Battery*
- USB 2.0 Bluetooth + EDR (Enhanced Data Rate) Module - Version 2.0 *(Factory Option)*
- 1.3M Pixel USB 2.0 PC Camera Module *(Factory Option)*
- 2nd SATA RAID Hard Disk Drive

### TV Tuner Module Options:
*For Windows XP (All Factory Options):*
- Analog TV Tuner Module with Mini-PCI Interface
  - OR
  - Digital TV Tuner Module with Mini-PCI Interface
*For Windows XP MCE:*
- Analog TV Tuner Module with Mini-PCI Interface

*For Windows Vista Home Premium and Ultimate Editions (Factory Option):*
- Analog TV Tuner Module with Mini-PCI Interface
  - OR
  - Analog TV Tuner Module with Mini-PCI Interface for *Windows Vista MCE*
Appendix D: Windows XP Information

This Appendix contains information (including control panel information, driver installation etc.) for users of the *Windows XP OS*. 
DVD Regional Codes

- **Changing DVD Regional Codes**

  Go to the Control Panel and double-click System > Hardware (tab), click Device Manager, then click the + next to DVD/CD-ROM drives. Double-click on the DVD-ROM device to bring up the Properties dialogue box, and select the DVD Region (tab) to bring up the control panel to allow you to adjust the regional code.

  DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is permanent. This cannot be altered even if you change your operating system or you use the module in another computer.

<table>
<thead>
<tr>
<th>Region</th>
<th>Geographical Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USA, Canada</td>
</tr>
<tr>
<td>2</td>
<td>Western Europe, Japan, South Africa, Middle East &amp; Egypt</td>
</tr>
<tr>
<td>3</td>
<td>South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong</td>
</tr>
<tr>
<td>4</td>
<td>South &amp; Central America, Mexico, Australia, New Zealand</td>
</tr>
<tr>
<td>5</td>
<td>N Korea, Russia, Eastern Europe, India &amp; Most of Africa</td>
</tr>
<tr>
<td>6</td>
<td>China</td>
</tr>
</tbody>
</table>

*Table D - 1 - DVD Region Codes*
Windows XP Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows XP (and most other Windows versions) are accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk drive, and a shortcut will usually be placed in the Start menu and/or the desktop. You can customize the look of the Start menu by right-clicking the Start menu and selecting Properties from the menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features in Windows (e.g. power, video, network, audio etc.). Windows XP provides basic controls for many of the features, however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all controls it may be necessary to toggle off Category View.
Audio Features

You can configure the audio options on your computer from the Sounds and Audio Devices, Windows control panel. For advanced options double-click the Realtek HD Audio Manager icon in the taskbar (or click the control panel) to bring up the Realtek Audio Configuration menus. The volume may also be adjusted by means of the $\text{Fn} + \text{F5/F6}$ key combination.

Figure D - 3
Realtek Audio Configuration Menus
Video Features

This computer features different PCI Express video cards, depending on the model purchased (see “Video Card Options” on page C - 3). You can switch display devices, and configure display options, from the Display Properties control panel in Windows as long as the appropriate video driver is installed.

To access Display Properties in Windows:
1. Click Start, point to Settings and click Control Panel (or just click Control Panel).
2. Double-click Display (icon) - In the appearsances and Themes category.
3. Click Settings (tab) in the Display Properties dialog box.
4. Move the slider to the preferred setting in Screen resolution \( \text{1} \) \((Figure D - 4 on page D - 6)\).
5. Click the arrow, and scroll to the preferred setting in Color quality \( \text{2} \) \((Figure D - 4 on page D - 6)\).
6. You can also access Display Properties by right-clicking the desktop and scrolling down and clicking Properties. Click Settings (tab) and adjust as above.
7. Open the Display Properties control panel, and click Advanced (button) \text{3} \((Figure D - 4 on page D - 6)\) to bring up the Advanced properties tabs.
8. The most advanced video controls are available from the ATI CATALYST(R) Control Center (tab) or GeForce Go...... (tab) control panels.
9. You can also access Display Properties by right-clicking the desktop and scrolling down and clicking Properties. Click Settings (tab) and adjust as above.
Video Card Options

Note that card types, specifications and drivers are subject to continual updates and changes. Check with your service center for the latest details on video cards supported.

The items listed in the Additional Properties window allow you to configure your display(s). If the items do not display you can either click the Additional Properties button, or click the icon.

Figure D - 4 - Display & Additional Properties
Display Devices & Options
Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display or TV as your display device. A VGA monitor/Flat Panel Display connects to the DVI-Out port, a TV to the S-Video-Out jack. The following display modes are available.

<table>
<thead>
<tr>
<th>NVIDIA Display Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single</td>
<td>One display device is used.</td>
</tr>
<tr>
<td>Clone</td>
<td>Both connected displays output the same view</td>
</tr>
<tr>
<td>Dualview</td>
<td>Both connected displays are treated as separate devices, and act as a virtual desktop</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ATI Display Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single</td>
<td>One display device is used.</td>
</tr>
<tr>
<td>Clone Mode</td>
<td>Both connected displays output the same view</td>
</tr>
<tr>
<td>Extended Mode</td>
<td>Both connected displays are treated as separate devices, and act as a virtual desktop</td>
</tr>
<tr>
<td>Stretched Mode</td>
<td>Both connected displays are treated as a single device, and act as a virtual desktop</td>
</tr>
</tbody>
</table>

*Table D - 2 - Display Options*
Display Modes

Single Display Mode
Only one of your displays is used.

Clone Mode
Clone Mode simply shows an exact copy of the Primary display desktop on the other display(s). This mode will drive multiple displays with the same content.

Dualview Mode
Dualview Mode treats both connected displays as separate devices, and they act as a virtual desktop resulting in a large workspace. When Dualview is enabled, you can drag any icons or windows across to the other display desktop. It is therefore possible to have one program visible in one of the displays, and a different program visible in the other display.

Extended Mode
Extended mode treats both connected displays as separate devices, and they act as a virtual desktop resulting in a large workspace.

Stretched Mode
Stretched mode (horizontally or vertically) treats both connected displays as a single device, and they act as a virtual desktop resulting in a large workspace.
Detaching Other Displays (for NVIDIA VGA)

If you prefer to use a monitor or flat panel display, connect it to the DVI-Out port at the rear of the computer.

1. Attach your external monitor to the DVI-Out Port (or TV to the 7-pin S-Video-Out jack), and turn it on.
2. Go to the Additional Properties in the GeForce Go/Quadro FX Properties control panel tab.
3. Select nView Display Settings.
4. Select the display mode from the nView Display Mode drop box.
5. Click Apply (and Yes to confirm the settings change).
6. Select the display option from the Primary Display/ Secondary Display dropbox. If you have a TV and external monitor/flat panel display attached you will have a number of available options. Select and Apply the appropriate option.

7. Click the display icon to select it, and then click the Device Settings button to make any adjustments for the selected display (including Screen Resolutions & Refresh Rates).

8. Click Apply to confirm any setting changes.
To Enable Extended Desktop (for NVIDIA VGA)

1. Attach your external monitor to the external monitor port and turn it on.
2. Click Start, point to Settings (or click Control Panel) and click Control Panel (if you are in Category View choose Appearance and Themes).
3. Double-click Display (icon).
4. Click Settings (tab).
5. Click the monitor icon (e.g. 2), and make sure you have checked “Extend my Windows desktop onto this monitor.” and click Apply.

Click the appropriate monitor icon (e.g. 2) to be able to select the option to extend the desktop on to it.

In this example the Primary monitor 1 is on the left, the secondary display 2 is on the right.

Figure D - 7 - Display Properties (Extended Desktop)
Windows XP Information

Attaching Other Displays (for ATI VGA)
If you prefer to use a monitor or flat panel display, connect it to the DVI-Out Port at the rear of the computer.
1. Attach your external monitor to the DVI-Out port (or TV to the 7-pin S-Video-Out port), and turn it on.
2. Select Displays Manager from the Graphics Settings Tree View pane.
3. Attached displays will appear in the Desktop and Display Setup box.
4. Drag and drop, or right-click, the attached display icon to bring up the Display Mode options.
5. Select an option from the menu, and click Yes to accept the settings.
6. Click OK to save the changes.

Figure D - 8 - Displays Manager

Detect Displays
Click Detect Displays (button) to automatically update the attached display information.

Configure the Display Detection Option from Display Options in the Graphics Settings Tree View pane. You can configure the Catalyst® Control Center to manually or automatically detect attached displays.
Power Management Features

The **Power Options** control panel icon in *Windows* (see page D - 3) allows you to configure power management features for your computer. You may conserve power through individual components such as the monitor or hard disk, or you may use either **Stand by** or **Hibernate** mode to conserve power throughout the system.

**Power Schemes**

You can set your computer to conserve power through individual components by means of **Power Schemes**. You can also adjust the settings for each scheme to set the monitor to turn off after a specified time, and the computer's hard disk motor to turn off if the hard disk drive has not been accessed for a specified period of time (if the system reads or writes data, the hard disk motor will be turned back on). The schemes may also be set to set a specified time for the system to enter **Stand by** or **Hibernate** modes.

![Figure D - 9 - Power Schemes](image)

Resuming Operation

Press the **Sleep/Resume** key combination (**Fn + F4**), or power button to resume from Monitor or Hard Disk Stand by.
Each *Windows Power Scheme* will also adjust the processor performance of your machine in order to save power. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery power).

Choose the *Home/Office Desk* scheme for maximum performance when the computer is powered from an AC power source. Choose the *Max Battery* scheme (bear in mind that this scheme may slow down the overall performance of the computer in order to save power) for maximum power saving when the computer is battery (DC power) powered. *Windows* will use *Portable/Laptop* as the default scheme.

**System Power Options**
You can use the system power options to stop the computer’s operation and restart where you left off. This system features *Stand by* and *Hibernate* sleep mode levels (*Hibernate* mode will need to be enabled by clicking the option in the *Hibernate* tab in the *Power Options* control panel).

**Hibernate Mode vs. Shutdown**
Hibernate mode and Shutdown are the same in that the system is off and you need to press the power button to turn it on. When you come back from hibernation, you can return to where you last left off (what was on your desktop) without reopening the application(s) and file(s) you last used.

**Stand by Mode vs. Hibernate Mode**
If you want to stay away from your work for just a while, you can put the system on Stand by instead of in hibernation. It takes a longer time to wake up the system from *Hibernate* mode than from *Stand by* mode.
Stand by
Stand by saves the least amount of power, but takes the shortest time to return to full operation. During Stand by the hard disk is turned off, and the CPU is made to idle at its slowest speed. All open applications are retained in memory. When you are not using your computer for a certain length of time, which you specify in the operating system, it will enter Stand by mode to save power.

Hibernate
Hibernate uses no power and saves all of your information on a part of the HDD before it turns the system off. Although it saves the most power it takes the longest time to return to full operation. You can set your computer to automatically enter Hibernate mode when the battery power is almost depleted. You will need to enable Hibernate mode from the Hibernate tab in the Power Options control panel. The system will resume from Hibernate mode by pressing the power button.

System Resume
The system can resume from Stand by mode by:
• Pressing the power button
• An incoming call received on the modem (if enabled)
• Network card activity (if enabled)
Configuring the Power Button

The power button may be set to send the computer into either **Stand by** or **Hibernate** mode. In **Stand by** mode, the LED will blink green. In **Hibernate** mode the LED will be off (battery). If you are in a power saving mode set to save power through individual components (e.g. hard disk, monitor), the LED will remain green.

---

**Sleep Button**

You may also configure the **Sleep/Resume** key combination (Fn + F4). In **Windows** this is referred to as the **Sleep button**.

---

*Figure D - 11 - Power Options (Advanced - Power Buttons)*

---

D - 16 Configuring the Power Button
Battery Information

Please follow these simple guidelines to get the best use out of your battery.

**New Battery**
Always completely discharge, then fully charge, a new battery (see “Battery FAQ” on page D - 20).

**Battery Life**
Your computer’s battery life is dependent upon many factors, including the programs you are running, and peripheral devices attached. **Power Options** (you may set low battery **Alarms** and actions, and check the **Power Meter** from the **Power Options** control panel), and settings in the OS will help prolong the battery life if configured appropriately.

*Figure D - 12 - Power Options (Alarm & Power Meter)*

**Low Battery Warning**
When the battery is critically low, immediately connect the AC/DC adapter to the computer or save your work, otherwise, the unsaved data will be lost when the power is depleted.
Windows XP Information

Battery life may be shortened through improper maintenance. To optimize the life and improve its performance, fully discharge and recharge the battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason see “Removing the Battery” on page 6 - 3.

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical outlet. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indicators” on page 1 - 7 for information on the battery charge status, and to “Battery Information” on page D - 17 for more information on how to maintain and properly recharge the battery pack.)

Conserving Battery Power

To conserve battery power:
Lower the brightness level of the LCD display. The system will decrease LCD brightness slightly to save power when it is not powered by the AC/DC adapter.
Close modem or communication applications when they are not being used.
Remove any unused Express Cards from the computer (Express Cards quickly use up battery power even if the system enters sleep mode).
Disconnect any unnecessary external devices.
Proper handling of the Battery Pack

- DO NOT disassemble the battery pack under any circumstances
- DO NOT expose the battery to fire or high temperatures, it may explode
- DO NOT connect the metal terminals (+, -) to each other

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being dropped), or any unusual smells emanating from the notebook battery, shut your computer down immediately and contact your service center. If the battery has been dropped we do not recommend using it any further, as even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire. It is recommended that you replace your computer battery every two years.
Battery FAQ

How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer by yourself even when you see a message that indicates the battery is critically low, just let the computer use up all of the battery power and shut down on its own. Disable the Power Options functions in the Control Panel, especially any Alarms (unclick the tickboxes - see page D - 17) and Schemes (change all the settings to Never - see page D - 13). As the battery nears the end of its life save and close any critical files.

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.

Caution

Danger of explosion if battery is incorrectly replaced.

Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.
Driver Installation

The Device Drivers & Utilities + User’s Manual CD-ROM contains the drivers and utilities necessary for the proper operation of the computer. Table D - 3 lists what you need to install, and it is very important that the drivers are installed in the order indicated.

Only install drivers for modules (WLAN, PC Camera, and Bluetooth) included in your purchase option.

Installation Methods (WinXP)
You may choose to install the drivers from the autorun program, or install them manually.

<table>
<thead>
<tr>
<th>WinXP SP2 Driver</th>
<th>Page #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chipset</td>
<td>Page - 24</td>
</tr>
<tr>
<td>Video (ATI)</td>
<td>Page - 24</td>
</tr>
<tr>
<td>Video (NVIDIA)</td>
<td>Page - 24</td>
</tr>
<tr>
<td>Audio</td>
<td>Page - 24</td>
</tr>
<tr>
<td>Modem</td>
<td>Page - 25</td>
</tr>
<tr>
<td>LAN</td>
<td>Page - 25</td>
</tr>
<tr>
<td>TouchPad</td>
<td>Page - 26</td>
</tr>
<tr>
<td>Card Reader/Express Card</td>
<td>Page - 26</td>
</tr>
<tr>
<td>Hot Key Utility</td>
<td>Page - 26</td>
</tr>
<tr>
<td>AutoMail Checker</td>
<td>Page - 27</td>
</tr>
<tr>
<td>PC Camera Module</td>
<td>Page - 28</td>
</tr>
<tr>
<td>Intel Wireless LAN Module</td>
<td>Page - 29</td>
</tr>
<tr>
<td>802.11b/g Wireless LAN Module</td>
<td>Page - 30</td>
</tr>
<tr>
<td>Bluetooth Module</td>
<td>Page - 31</td>
</tr>
<tr>
<td>TV Tuner Module</td>
<td>Page - 32</td>
</tr>
<tr>
<td>RAID Setup</td>
<td>Page - 34</td>
</tr>
</tbody>
</table>

Table D - 3 - Driver Installation
What to Install

This section covers driver and utility installation instructions for Windows XP Home & Professional. Insert the Device Drivers & Utilities + User’s Manual CD-ROM, click Install WinXP Drivers (button) and then click the appropriate driver name from the Drivers Installer menu and then follow the instructions to install the driver. Alternatively Click Start and navigate (Browse..) to follow the manual setup instructions.

1. Check the driver installation order from Table D - 3 (the drivers must be installed in this order) which is the same as that listed in the Drivers Installer menu below.
2. Click to select the driver you wish to install, after installing each driver it will become greyed out (if you need to reinstall any driver, click the Unlock button).
3. Follow the instructions for each individual driver installation procedure as listed on the following pages.

Figure D - 13 - Drivers Installer Screen 1

Figure D - 14 - Drivers Installer Screen 2
Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it may be necessary to uninstall the original driver. To do this go to the Control Panel in the Windows OS and double-click the Add/Remove Programs item. If you see the individual driver listed (if not see below), uninstall it, following the on screen prompts (it may be necessary to restart the computer). Go to the appropriate section of the manual to complete the update/reinstall procedure for the driver in question.

If the driver is not listed in the Add/Remove Programs item:

1. Click Start (menu), point to Settings and click Control Panel (or click Start > Control Panel).
2. Double-click System (icon); System (icon) is in Performance and Maintenance (category).
3. Click Hardware (tab) > Device Manager (button).
4. Double-click the device you wish to update/reinstall the driver for (you may need to click “+”).
5. Look for the Update Driver button (check the Driver tab) and follow the on screen prompts.

Windows XP Service Pack 2

Make sure you install Windows XP Service Pack 2 (or a Windows XP version which includes Service Pack 2) before installing any drivers. Service Pack 2 includes support for USB 2.0.

If you have upgraded the system by installing Service Pack 2 (i.e. your Windows XP version does not include Service Pack 2) then follow these instructions:

1. Click Start (menu), point to Settings and click Control Panel (or click Control Panel).
2. Double-click System (icon); System (icon) is in Performance and Maintenance (category).
3. Click the Hardware (tab) > Device Manager (button).
4. Click “+” next to Other Devices (if its sub-items are not shown).
5. Right-click Universal Serial Bus (USB) Controller and select Uninstall > OK (if you don’t see the item then there is no need to take any further action).
6. Restart the computer and it will find the USB 2.0 controller.
Windows XP Information

Chipset
1. Click 1.Install Chipset Driver > Yes.
   OR
   Click Start (menu) > Run... and navigate (Browse..) to
   D:\Drivers\00Chipset\setup.bat and click OK.
2. Click Next > Yes > Next.
3. Click Finish to restart the computer.

Video (for ATI)
1. Click 2.Install Video Driver > Yes.
   OR
   Click Start (menu) > Run... and navigate (Browse..) to
   D:\Drivers\01Vga\atiwhql\Setup.exe and click OK.
2. To continue click Next > Yes.
3. Click Express: Recommended (click Continue Anyway if asked if you want to continue at any time).
4. Click Finish to restart the computer.

Video (for NVIDIA)
1. Click 2.Install Video Driver > Yes.
   OR
   Click Start (menu) > Run... and navigate (Browse..) to
   D:\Drivers\01Vga\nvg7071\setup.exe and click OK.
2. Click Next (click Continue Anyway if asked if you want to continue at any time).
3. Click Finish to restart the computer.

Audio
1. Click 3. Install Audio Driver > Yes.
   OR
   Click Start (menu) > Run... and navigate (Browse..) to
   D:\Drivers\02Audio\Setup.exe and click OK.
2. Click Next (click Continue Anyway if asked if you want to continue at any time).
3. Click Finish to restart the computer.
Modem
1. Click 4.Install Modem Driver > Yes.
   OR
   Click Start (menu) > Run... and navigate (Browse..) to D:\Drivers\03Modem\Setup.exe and click OK.
2. Click OK > OK.
3. The modem is now ready for configuration.

LAN
1. Click 5.Install LAN Driver > Yes.
   OR
   Click Start (menu) > Run... and navigate (Browse..) to (one of the following):
   D:\Drivers\04LAN\Marvell\SetupYukon-Win.exe
   D:\Drivers\04LAN\Realtek\Setup.exe
   and click OK.
2. Click Next.
   If you have the Marvell LAN module (otherwise go to step 4), click the button to accept the license, and then click Next.
3. Click Install.
4. Click Finish.
5. The network settings can now be configured.

Modem Country Selection
Be sure to check if the modem country selection is appropriate for you (Control Panel > Phone and Modem Options).
Windows XP Information

TouchPad
1. Click 6.Install Touchpad Driver > Yes.
   OR
   Click Start (menu) > Run... and navigate (Browse...) to
   D:\Drivers\05Touchpad\Synaptics\SETUP.EXE
   OR
   D:\Drivers\05Touchpad\Elantech\Setup.exe and click OK.
2. Click Next > Next (click Continue Anyway if asked if you want to continue at any time).
3. Click Finish to restart your computer.

Card Reader/ExpressCard
1. Click 7.Express Card Interface > Yes.
   OR
   Click Start (menu) > Run... and navigate (Browse...) to
   D:\Drivers\06PCMCIA\setup.exe and click OK.
2. Click Next > Finish.

Hot Key Utility
1. Click 8.Install Hotkey Utility Driver > Yes.
   OR
   Click Start (menu) > Run... and navigate (Browse..) to
   D:\Drivers\07AP-Key\AKSETUP.exe and click OK.
2. Click Next.
3. Click Finish to restart your computer.
AutoMail Checker
1. Click **Optional > Yes** from the *Drivers Installer* Menu.
2. Click **4.AutoMail > Yes**.
   OR
   Click **Start (menu) > Run...** and navigate (Browse..) to 
   \D:\Drivers\11AutoMail\SETUP.EXE and click **OK**.
3. To continue click **Next > Next > Finish**.
4. Run the program from the **Auto Mail Checker** in the **Start** menu (**Start > Programs/All Programs > Auto Mail Checker**).
5. Click the icon ✗ in the taskbar to input the e-mail account details.

Module Drivers
See the following pages for the driver installation procedures for any of the optional modules included in your purchase configuration.

Wireless LAN & Bluetooth Modules

**Wireless Device Operation Aboard Aircraft**
The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are **OFF** if you are using the computer aboard aircraft.

**Power Toggle for the Wireless LAN and Bluetooth Modules**
Enable power to the modules as follows:
- Fn + F11 = Wireless LAN Module Power Toggle
- Fn + F12 = Bluetooth Module Power Toggle
The LED indicator 📡 will be **green** if the WLAN or Bluetooth modules are on.
Windows XP Information

PC Camera Driver Installation

1. Make sure the module is powered on, and then insert the *Device Drivers & Utilities + User’s Manual CD-ROM* into the CD/DVD drive (click *Cancel* if you see a “*New Hardware Found*” message).
2. Click *Optional > Yes*, and then click 1.1.3M PCCam > Yes.
3. Click *Install Products*.
4. Choose the language you prefer and click *OK*.
5. Click *Next* (click *Continue Anyway* if asked if you want to continue).
6. Click *Finish* to restart the computer.
7. Run the *BisonCap* application program from the shortcut on the desktop, or from the *BisonCam* item in the *Start > Programs/All Programs* menu (if the hardware is turned off use the *Fn + F10* key combination to turn it on again).

BISONCAP

*BisonCap* is a video viewer useful for general purpose video viewing and testing, and can capture video files to .avi format.

Latest PC Camera Driver Information

Check the PC Camera CD and any accompanying insert pages, for the latest updated information on the PC Camera driver, which may override the information provided here.
Intel WLAN Driver Installation
1. Make sure the module is powered on, and then insert the *Device Drivers & Utilities + User’s Manual CD-ROM* into the CD/DVD drive.
2. Click **Optional > Yes**, and then click **2.Wireless Lan > Yes**.
3. Click **Install Software** (button).
4. Click the button to accept the license and click **Next > Next > OK**.
5. Click **OK** to complete the installation.
6. You can configure the settings by going to the **Intel (R) PROSet Wireless** control panel (Start > Programs/All Programs > Intel PROSet Wireless), or by double-clicking the taskbar icon 📱.

![Figure D - 15 - Intel PROSet/Wireless](image-url)
802.11 b/g WLAN Driver Installation

1. Make sure the module is powered on, and then insert the **Device Drivers & Utilities + User’s Manual CD-ROM** into the CD/DVD drive.
2. Click **Optional > Yes**, and then click **2.Wireless Lan > Yes**.
3. Choose the language you prefer and click **OK**.
4. Click **Next** (click **Continue Anyway** if asked if you want to continue at any time).
5. Click **Finish** to complete the installation.
6. The operating system is the default setting for Wireless LAN control in **Windows XP**.
7. Access any available wireless networks from the Network Connections control panel in **Windows** (Start > Settings > Network Connections OR Start > Connect To > Show all Connections) or by clicking the taskbar icon

![Wireless Network Control Panels](image)
Bluetooth Driver Installation

1. Make sure the module is powered on, and then insert the Device Drivers & Utilities + User’s Manual CD-ROM into the CD/DVD drive.
2. Click Optional > Yes, and then click 3. Bluetooth > Yes.
3. Choose the language you prefer, and click OK.
4. Click Next.
5. Click the button to accept the license agreement, and then click Next.
6. Click Next > Next > Install.
7. Click Finish > Yes to restart the computer.
8. The IVT Corporation BlueSoleil - Main Window screen will appear on restart.
9. You can configure the settings at any time by going to the IVT Corporation BlueSoleil - Main Window control panel (Start > Programs/All Programs > IVT BlueSoleil), or by clicking the taskbar icon .
10. View the BlueSoleil User Guides from the Help Menu (press F1) in the IVT Corporation BlueSoleil - Main Window control panel.

Figure D - 17 - Bluetooth Control Panel & User Guides
Mini-PCI TV Tuner Module

You may have one of three *optional* Mini-PCI TV Tuner modules supplied with your computer, depending on your purchase configuration. The optional TV Tuner allows you to watch TV, play music CDs, video conference and capture still images and video on your PC.

The **LifeView FlyDVB-T Hybrid** (for both analog and digital inputs) **Mini-PCI TV Tuner Module** comes with a remote control unit, and a CD containing the LifeView Utility software.

The **YUAN PVR MPC622-MCE** TV Tuner module comes with a remote control unit, and a CD containing driver software for *Windows XP Media Center Edition*.

The **YUAN PVR MPC788** TV Tuner module comes with a remote control unit, and a CD containing driver and application software for *Windows XP (Home or Professional Editions)*.

Installing the LifeView FlyDVB-T Driver

1. Insert the driver *CD-ROM* into the CD/DVD drive.
2. Double-click **LifeView DTV and Driver**.
3. Click **Next > Finish**.
4. Choose the language you prefer, and click **OK**.
5. Click **Next > Next**.
6. Click **Finish** to restart the computer.
7. Run the application from the **Start > Programs/All Programs > LifeView** and select the **LifeView DTV** program, or double-click the icon on the desktop.

TV Antenna

The TV antenna supplied with any TV Tuner module is intended for indoor use only. Please do not use your TV Tuner module outdoors.
Installing the MPC622-MCE Driver
1. Insert the driver CD-ROM into the CD/DVD drive.
2. Click Start (menu) > Run... and navigate (Browse..) to D:\MPC622_Setup_v91.exe
3. Click Next > Finish.
4. The TV Tuner is fully supported within Windows XP Media Center Edition, however to get the most out the module it is recommended that you use a program such as Cyberlink Power DVD.

Installing the MPC788 Driver & Cyberlink PowerCinema
1. Insert the driver CD-ROM into the CD/DVD drive.
2. Choose the Setup Language you prefer, and then click Next.
3. Click Next > Next.
4. Click the button to accept the license agreement for Microsoft(R) DirectX(R), and then click Next > Next > Finish.
5. Choose the language you prefer for Cyberlink PowerCinema, and then click OK.
6. Click Next > Yes.
7. Type in the Cyberlink PowerCinema CD Key provided (make sure you also input a User and Company Name), and then click Next.
8. Click Next > Next > Next > Finish.
9. Click Next > Install > Finish to install Sim-HID.
10. Click Finish > Finish to restart the computer.
11. Run the application from the Start > Programs/All Programs > Cyberlink PowerCinema and select the PowerCinema program, or double-click the icon on the desktop.
Setting Up SATA RAID

If your purchase includes the RAID (Redundant Array of Independent Disks) option, the following pages provide an introduction to configuring your hard disk(s) in RAID mode. You may use your hard disks in combination with Striping (RAID 0) or Mirroring (RAID 1) for either fault tolerance or performance.

### Table D - 4 - RAID Levels

<table>
<thead>
<tr>
<th>RAID Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID 0</td>
<td>Identical drives reading and writing data in parallel to increase performance. RAID 0 implements a striped disk array and the data is broken into blocks and each block is written to a separate disk drive.</td>
</tr>
<tr>
<td>RAID 1</td>
<td>Identical drives in a mirrored configuration used to protect data. Should a drive that is part of a mirrored array fail, the mirrored drive (which contains identical data) will handle all the data. When a new replacement drive is installed, data to the new drive is rebuilt from the mirrored drive to restore fault tolerance.</td>
</tr>
</tbody>
</table>

Prepare the following before setting up your Serial ATA hard disks in RAID mode:

1. An operable computer with a floppy drive (to create a SATA RAID driver diskette).
2. The Device Drivers & Utilities + User’s Manual CD-ROM.
3. An external USB floppy disk drive.
4. An external USB CD/DVD device drive (the Microsoft Windows OS CD should be inserted into this drive).
5. A prepared formatted blank 3.5" 1.44MB floppy diskette.
6. The second hard disk installed in the optional device drive bay.
SATA RAID Setup Procedure

1. Go to the operable computer running Windows XP and insert a prepared formatted blank 3.5” 1.44MB floppy diskette.


3. Click Start (menu) > Run... and navigate (Browse..) to D:\Others\f6flpy\f6flpy32\F6flpy32.exe and click OK.

4. Make sure the formatted blank 3.5” 1.44MB floppy diskette is inserted, and click OK.

5. A SATA RAID driver diskette will now be created for you.

6. Remove the SATA RAID driver diskette.

7. Attach the external USB CD/DVD device drive (containing the Microsoft Windows OS CD) to the computer.

8. Start-up your notebook computer and press <F2> to enter the BIOS.

9. Go to the Advanced menu.

10. Select "Advanced Chipset Control" and press Enter.

11. Select "SATA RAID Function:" and press Enter, then select "Enabled" and press Enter.

12. Press Esc and go to the Boot menu.

13. Set the external CD/DVD-ROM Drive (make sure the Microsoft Windows OS CD is inserted) as the first device in the boot order from the Boot Device menu.

14. Attach the external USB floppy disk drive to one of the notebook computer’s USB ports.

15. Select Exit Saving Changes from the Exit menu (or press F10 and Enter) and press Enter to exit the BIOS and reboot the computer.

16. Press Ctrl + i to enter RAID configuration menu.


18. Type the RAID volume name and then press Tab or Enter to advance to the next field.
19. Specify the RAID level (RAID 0 or RAID 1 - see Table D - 4, on page D - 34) and then press Tab or Enter to advance to the next field.
20. Press Enter and the system will select the physical disks to use.
21. Press Enter and select (if applicable) the Strip Size (best set to default).
22. Press Enter and select the Capacity size (best set to default).
23. Press Enter to Create Volume.
24. Confirm the selection by pressing Y.
25. This will now return to the main menu.
26. Select 4.Exit and press Enter, then press Y to exit the RAID configuration menu.
27. As the computer starts up, press a key when you see the message "Press any key to boot from CD".
28. Press the F6 key when you see the message “Press F6 if you need to install third party SCSI or RAID driver”.
29. When the Windows Setup menu appears (Windows will load a number of files before the Setup menu appears), press the <S> key to "Specify Additional Device".
30. Insert the SATA RAID driver diskette into the external USB floppy drive, and press Enter.
31. Use the arrow keys to scroll down and select Intel(R) 82801GHM SATA RAID Controller (Mobile ICH7MR/DH), and press Enter.
32. The system will now read from the floppy disk drive and then return to the Windows Setup menu.
33. Press Enter to continue installing the operating system as normal (see your Windows documentation if you need help on installing the Windows OS).
34. Install the Windows drivers as per Table 4 - 1, on page 4 - 3.